Sci2: A Tool of Science of Science
Research and Practice Tutorial

Dr. Katy Bérner & Joseph Biberstine
Cyberinfrastructure for Network Science Center
Information Visualization Laboratory

School of Library and Information Science

Indiana University, Bloomington, IN

With special thanks to Kevin W. Boyack, Chin Hua Kong, Micah Linnemeier, Russell ]. Duhon, Patrick
Phillips, Chintan Tank, Thomas Smith, Nianli Ma, Scott Weingart, Hanning Guo, Mark A. Price, Angela M.
Zoss, Ted Polley, and Sean Lind

Please (1) get a name tag, (2) download the

Sci2 Tool from and

(3) complete the Pre-Tutorial Questionnaire

NSF's Stafford Place I Conference Center in Arlington, Virginia
Monday, Oct 17, 2011 * S8am — 11:30am
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» 'These slides
http://ivl.slis.indiana.edu/km/pres/2011-borner-scitutorial-nsf.pdf

» Sci2 Tool Manual v0.5.1 Alpha
http://sci2.wiki.cns.iu.edu

» Sci2 Tool v0.5.1 Alpha (May 4, 2011)

http://sci2.cns.iu.edu

» Additional Datasets
http://sci2.wiki.cns.iu.edu/2.5+Sample+Datasets
» Additional Plugins
http://sci2.wiki.cns.iu.edu/3.2+ Additional+Plugins

Or copy them from the DVD or memory stick.




° : Tutorial Overview

8:00a Welcome and Overview of Tutorial and Attendees

8:15a Plug-and-Play Macroscopes, OSGi/CIShell Powered Tools

8:30a Sci2 Tool Basics

» Download and run the Sci2 Tool

» Load, analyze, and visualize family and business networks

»  Studying four major network science researchers
- Load and clean a dataset; process raw data into networks
- Find basic statistics and run various algorithms over the network
- Visualize as either a circular hierarchy or network

10:00 Break

10:15a Sci2 Tool Novel Functionality

» Horizontal line graph of NSF projects

» Geospatial maps aggregated by congressional districts

» Evolving collaboration networks

» R-Bridge

11:00a Outlook and Q&A

11:30 Adjourn

.

° : Tutorial Overview

8:00a Welcome and Overview of Tutorial and Attendees
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iy Using the Sci2 Tool to Visualize Tutorial Registrants

Use File > Read’ to load cleaned Sci2TutorialRegistrants.csv

A B C
1 Last Name Affiliation Background
2 DiGangi Loyola University Maryland Statistics
3 Cogburn COTELCO, American University/ Syracuse University Information Science and Technology
4 Coleman Duke University
5 McCain Drexel University Life stiences, information science, bibliometrics
6 Hewes NIH Chemistry
7 Fearon NIH Biology
& Webber NIH

Total of 79 registrants on Oct 10, 2011. Affiliations with more than two participants:

Affiliations #
NSF 26
NIH

IDA Science and Technology Policy Institute
AAAS

AAAS/NSF

Discovery Logic, Thomson Reuters

DoE

NOAA

USDA
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it Using the Sci2 Tool to Visualize Tutorial Registrants

Use File > Read’ to load cleaned Sci2TutorialRegistrants.cs

A B Cc
1 Last Name Affiliation Background
2 DiGangi Loyola University Maryland Statistics % Sci? Tool
L " % L
3 Cogburn COTELCO, American University/ Syracuse University Information Scie File m PreprocessingimAnaksinmt
4 Colen"lan Duke Unlv_ersm./ G.radue?te Stude! 8 '{ Rermove IS Duplicate Records
5 McCain Drexel University Life Sciences, In |i ey Remove Rows with Multitudinous Fields
6 Hewes NIH Chemistry fThe
7 Fearon NIH Biology ISciel Extract Directed Network
8 Webber NIH Ezaﬁ Extract Bipartite Network
M
. - . . Extract Paper Citation Network
™ fi
Run ‘Data Preparation > Extract Bipartite Network’ ore
- X
With parameter values: ,mmm...?..mm 1f e cokm
them. = .
First column lL.ulee 3 2]
Optional: Calculate Node Degree b 3 o
Text Delmiter 1A 2'
Aggregate Function Fie [ C: Lisers haty/Desktop TOOLS 502-2011.09.30 &ml 3]
Visualize resulting ‘Bipartite network [ [

Jfrom Last Name and Org’ using ‘Visualization > Network > GUESS” and
Layout > GEM’, Layout > Bin Pack’




S aiEs  Sci2 Tool — Visualize Workshop Attendees:
Bi-partite People-Affiliation Network

ch & practice

sLoyola University Maryland

«Universidad Indugtrial De Santander
+The Ohio State University
. +Sri International

.Department Of State . <Neon, Inc.
- {Doe
. + JUsda
«Syracuse University +«Eversole Associates

* .lda Science And Technology Poljcy Institute
«Cotelco, &mﬁjcan Uni
. _smvery‘f.og , Thomson Reulers* .Science And Technology Pdlicy Institute

-Science-metrix
, +Federal Highway Administration, Turner Fairbank
«Nele
«Mitre Corporation , *George Mason University
o '.p;‘. . .A;aas Apa’ " .Drexel University
'.." .l ® -‘ *

* .University Of Maryland @ 1.astName
! @ Affiliation

* .Duke University
. «Noaa

“.Institute For Market Transformation

Sci2 Tool — Visualize Workshop Attendees:
Bi-partite People-Background Network

Sfarch & practice

Use File > Read’ to load cleaned Sci2TutorialRegistrants.cs

A B C
1 Last Name Affiliation Background
2 DiGangi Loyola University Maryland Statistics % Sci? Tool
" r
3 Cogburn COTELCO, American University/ Syracuse University Information Scie File m PreprocessingimAnaksinmt
4 Colen.'lan Duke Univ_ersih./ G.radue?te Stude! . Rermove IS Duplicate Records
5 McCain Drexel University Life Sciences, In lWe!( Remove Rows with Multitudinous Fields
6 Hewes NIH Chemistry FThe
7 Fearon NIH Biology | Sciet Extract Directed Network
8 Webber NIH gaﬁ Extract Bipartite Network
M
e . . Extract Paper Citation Network
™ fi
Run ‘Data Preparation > Extract Bipartite Network’ e
- _ X
With parameter values e
. entries, enter the h delemits
them,
= Frst coumn [Last name -l e
Calculate Node Degree 2!
G Second cokomn [eadgromna = e
—
Analysi deling li R Hep miter [l ﬁ
yi= Functon Fie [ C: Users bty Deskiop TOOLS 2. 2011090 mL?_j
[Cox ] corel

y and run ‘Visualization > Network > GUESS.
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scicpce of Scicnce

Sci2 Tool — Visualize Workshop Attendees:
Bi-partite People-Background Network

* JMaterials Stience
» .Biomedical Engineering Genetics

JStatistics

JNeuropsychiatry
eurospsychology

.Library And Information Sclence G
«Science And Technology Pel
.Data

iey

JPlant Pathglogy ogy.Of Sclence

. Inf tion Scie And Technol
eanad ormation Science nology

sIndustrial Engineering
JHei S
* Visualization
+Psychology
. -Pharmacology

eNeuroscience +Entomology

FRsta o

JQceanography

Md. .
nce it + Neurobiology

.. #Bialogy +Technology And Public Polity

«Energy Policy & Climate
-Onmguerqg:b

. +Bioengineering

+Elecirical And Computer Engineering

«Sociology H
UNE .Il?fgrn'mﬁm Technology Maflagement
JAccounting

Color/label via

+Fregchinternational Affairs «Education

~Civili irork ¥ .Science

sLibrary Science

«Information Science®
v-oife Sclonces™y YOS
Educati .Bibliometrics
Socian S con
. .Large-scale Planning

. Last Name
@ Background

«Economics
+Public Policy

Public Health
«Epidemiology

Technology And Policy
«Social Psychologist

" Environmental Studies

Size coded by degree.

Object: [nodes based on -> | v/ Property: [bipartitetype w| Operator: [== v] value: [Background ]

~| From: [2

| To: [20

Size code using |nodes v/ |wotades

|| DoResazeLinear | 9
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Sci2 Tool — Visualize Workshop Attendees:
Bi-partite People-Background Network

Chacko
Sul
B Kaske
Stall *.Basner Geary
Toole {Records Fo
. «Nichols . Cogbi Alexander
Galvin-donoghue L uem
+Camavos -
.Di Gangi Krueger
. s MNireya
Singpurwalla «Robinson Moulden Dunne
. -‘Engel P * Webber
«Hein
«KImmed
* «Cragin Mo i . '
. «Morris nsen H
Wiliams 24 Barkis lamann
+ sLudwig Zemankova Gom
b lexsak i sLederhendler
. +Spears
u.!(umuseuko Eﬁgﬁftﬂfe .
“Russell . T Wheaer eHule .
$epth Healy
-C‘ﬂ&?Fd Belter —
i sy, «Evans
Coleman  ,Dickerson
Mecdfihaniyal | Senthi
“Clemins ! l-ttg::?gsmsen
« «Wilkerson . Pena
*Hewes .
Halner-eaton e aliin " Last Name
Cull edbeller
Mo R her ~CUERIGH @ Background
. e o Schweitzer
ichekanova .
Puggal I Size coded by degree.
p ~agner Wiey

Color/label via bt [nodesbased on -> | v] Property: Operator: [1= | Value: [Badkground || 10




Wordle.net of “Interest to Learn” Response

mpacts

~NSF ....learn

pamcubr ' . @
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Visualization = PapP: ers
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O Workshop Overview

8:15a Plug-and-Play Macroscopes, OSGi/CIShell Powered Tools
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COMMUNICATIONS
ACM

Borner, Katy. (March 2011).
Plug-and-Play Macroscopes.

P|ug -and-Pl ay Commmunications of the ACM,
Macroscopes JEEKEICS

by Katy Borner
A\

Video and paper are at

Plug-and-Play
Macroscopes

Take terra bytes of data

Identity trends




Macroscopes

Decision making in science, industry, and politics, as well as in daily life, requires
that we make sense of data sets representing the structure and dynamics of
complex systems. Macroscopes provide a “vision of the whole,” helping us
“synthesize” the related elements and enabling us to detect patterns, trends, and
outliers while granting access to myriad details. Rather than make things larger or

smaller, Macroscopes let us observe what is at once
too great, slow, or complex for the human eye
and mind to notice and comprehend.

Microscopes Telescopes Macroscopes

15

Plug-and-Play Macroscopes

While microscopes and telescopes are physical instruments,
macroscopes resemble COﬂtiIlllOUSly Changing bundles of

software plug-ins. Macroscopes make it easy to select and combine

algorithm and tool plug-ins but also interface plug-ins, workflow support, logging,
scheduling, and other plug-ins needed for scientifically rigorous yet effective work.

They make it easy to share plug-ins via email, flash drives, or online. To use new
plugins, simply copy the files into the plug-in directory, and they appear in the tool

menu ready for use. No restart of the tool is necessary. Sharing
algorithm components, tools, or novel
interfaces becomes as easy as sharing images
on Flickr or videos on YouTube. Assembling
custom tools is as quick as compiling your
custom music collection.

16




‘g‘é’:c |Shel] 0sGi & Cyberinfrastructure Shell (CIShell)

» CIShell (http://cishell.oro) is an open soutce software specification for the integration
and utilization of datasets, algorithms, and tools.
» It extends the Open Setvices Gateway Initiative (OSGi) (http://osgi.org), a

standardized, component oriented, computing environment for networked services
widely used in industry since more than 10 years.

» Specifically, CIShell provides “sockets” into which existing and new datasets,
algorithms, and tools can be plugged using a wizard-driven process.

Alg A Workflow
CILShell Wizards
Al e ~ Workflow
Alg | L2 “_’
TEREE Workflow
Tool :
Tool el 3 5 ‘/ | Workflow

17

1.\.
g:’c IS }"] (_‘h] ] OSGi/CIShell-Powered Tools Support Algorithm Sharing

Different datasets/formats.
Diverse algorithms/tools written in
many programming languages.

18




Tutorial Overview

8:30a Sci2 Tool Basics
» Download and run the Sci2 Tool

>
>

YV VVYY
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Science of Science (Sci2) Tool
http://sci2.cns.iu.edu

h & practice

» Explicitly designed for SoS research and practice, well documented, easy to use.

» Empowers many to run common studies while making it easy for expotts to
perform novel research.

A\

Advanced algorithms, effective visualizations, and many (standard) workflows.

» Supports micro-level documentation and replication of studies.

A\

nature

O P | N | O N range of scientists’ work

Is open source—anybody can review and extend the code, or use it for
commercial purposes.

SUMMARY

o Existing metrics have known flaws

e Areliable, open, joined-up data
infrastructure is needed

o Data should be collected on the full

Vol 464|25 March 2010

e Social scientists and economists
should be involved

Let's make science metrics more scientific

To capture the essence of good science, stakeholders must combine forces to create an open, sound and
consistent system for measuring all the activities that make up academic productivity, says Julia Lane.

20
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Epce of Seicnce

Sci? Tool — “Open Code for S&T Assessment”

Jaint Co-Authorship Network
p

OSGi/CIShell powered tool with NWB plugins and

many new scientometrics and visualizations plugins.

PERERET LR et tee i gt ' Nede SomfcCalor il S ¢ ol

| P4 . @ =—.

— R — — —

o Sci Maps GUESS Network Vis
Horizontal Time Graphs

Bérner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Dubon, Russell Jackson, Phillips, Patrick, Ma, Nianli, Zoss,
Abngela, Guo, Hanning & Price, Mark. (2009). Rete-Netzwerk-Red: Analyzing and 1 isualizing Scholarly Networks
Using the Scholarly Database and the Network Workbench Tool. Proceedings of ISST 2009: 121h International Conference
on Scientometrics and Informetrics, Rio de Janeiro, Brazil, July 14-17 . V'ol. 2, pp. 619-630.

21

Atool for
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Sci? Tool Visualizations

W% Sci Tool
File Preprocessing Modeling Analysi l" lizati I'SL trics  Help
sole| GUESS
GnuPlot

‘Welcome to the Science of Science Tool (Sci
The development of this tool is supported in

| Metwork Science center and the School of Li|
Indiana University, the National Science Foul
and 05-0715303, and the James 5. McDonnel
Cyberinfrastructure portal (http:f/scislis.ind

The primary investigators are Katy Bomer, In
SciTech Strategies Inc. The Sci’ tool was dew

(http:linwhb.slis.indiana.edu).

Please cite as follows:
Sci® Team. (2009). Science of Science Tool. Ir
Strategies Inc., http:fiscislis.indiana.edu.

B scheduler]

[ Remove completed

Radial Tree/Graph (prefuse alpha)
Radial Tree/Graph with Annotation (prefuse beta)

Tree View (prefuse beta)

Tree Map (prefuse beta)

Force Directed with Annotation (prefuse beta)

Horizontal Line Graph

Circular Hierarchy

Geo Map (circle an

Aap (region colonng annotations)
Image Viewer

RefMapper

! Algorithm Narme Date

& Extract Co-Author Metw... 09/03/2009
09/03/2009

& Load and Clean ISIFile

Time % Com

00:15:20 AM | ———
00:15:05AM | —

J. Duhon, Patrick A. Phillips, Chintan Tank, al Fruck Reingold with A tation (prefuse beta)

Cyberinfrastructure Shell (http:f/cishell.org)

for Network Science Center (http://cns.slis.if Dl (VxOrd) b
Marwy algorithm plugins were derived from t Specified (prefuse beta)

Circular Hierarchy

E]




Workflow Design
(selecting Datasets, Algorithms and Parameters)
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23

Type of Analysis vs. Level of Analysis

Micro/Individual
(2-100 records)

Meso/Local
(101-10,000 records)

Macro/Global
(10,000 < records)

Statistical
Analysis/Profiling

Temporal Analysis
(When)

Geospatial Analysis
(Where)

Topical Analysis
(What)

Network Analysis
(With Whom?)

24




B R {0l for
B Ao hcience

Type of Analysis vs. Level of Analysis

;&..pxiclilzz Covered T()day:

Micro/Individual
(2-100 records)

Meso/Local Macro/Global
(101-10,000 records) | (10,000 < records)

Statistical
Analysis/Profiling

(With Whom?)

Temporal Analysis o R
(When) & °d ‘0;;@
@ 9

Geospatial Analysis y ML
(Where) b I
Topical Analysis N
(What) i . =
Network Analysis Z AW

9T -

25

Sci? Tool — Supported Data Formats

Input:

Network Formats

»  GraphML (*.xml or *.graphml)
»  XGMML (*.xml)

»  Pajek NET (*.net)

» NWB (*.awb)

Scientometric Formats

IST (*.isi)

Bibtex (*.bib)

Endnote Export Format (*.enw)
Scopus csv (*.scopus)

NSF csv (*.nsf)

Other Formats

»  Pajek Matrix (*.mat)

»  TreeML (*.xml)

> Edgelist (*.edge)

» CSV (*.csv)

Y V V V VY

Formats are documented at http://sci2.wiki.cns.iu.edu/display/SCI2TUTORIAL/2.3+Data+Formats.

Output:

Network File Formats

GraphML (*.xml or *.graphml)
Pajek . MAT (*.mat)

Pajek NET (*.net)

NWB (*.nwb)

XGMML (*.xml)

CSV (*.csv)

VVVYVYVVY

Image Formats

> JPEG (“jpg)
» PDF (*.pdf)

> PostScript (*.ps)

26
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Gnuplot GUESS
portable command-line driven exploratory data analysis and visualization tool
interactive data and function plotting for graphs and networks.
utility http://www.gnuplot.info/. https://awb.slis.indiana.edu/community/?n=Vi

sualizeData. GUESS.
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Sci2 Tool v0.5 Alpha (April 4, 2011)

Can be freely downloaded for all major
operating systems from

fr A M budng 31 canps mag

http://sci2.cns.iu.edu

Select your operating system from the

pull down menu and download.

Unpack into a /sci2 directory.
Run /sci2/sci2.exe

Sci2 Manual is at e
http://sci2.wiki.cns.iu.edu SR

Phewse clie 11

Cite as e e e

Arknentedgem

Sei? Team. (2009). Science of Science (Sci) Tool. § - e
Indiana University and SciTech Strategies,
hitp:/ [ sci2.cns.in.edn = e B TR
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i Sci’ Tool: Download, Install, and Run

Sci2 Tool v0.5 Alpha (April 4, 2011)
Supports ASCII UTF-8 characters
Web-based Yahoo! and desktop Geocoders
U.S. and World geomapper

Customizable stop word lists _ :

. 1) 5¢i2-N-1.0.0.201008130505NGT-macosx.carbon.ppc.zip
Merging of networks 1) 5¢i2-N-1.0.0.201008130505NGT-macosx.carbon.x86.zip
New home page, wiki-based tutorial 1 sci2-N-10.0.201008130505NGT-macosx.cocosx86_64.zip
1) 5¢i2-N-1.0.0.201008130505SNGT-win32.win32.x86.zip

YV VVYYVYY

Bug fixes, streamlined workflows

Sci2 Tool runs on Windows, Mac, and Linux.

UﬂZiP- bscanL | _ 91,374KB
. . sci2 | Browse with Corel Paint Shop Pro Photo X2
Run /SC12/SC12.CXC J Open Command Prompt Here
Extract All...
Scan for Viruses... :
1-Zip » Open archive
Open With... Extract files...
& Magiclso v Extract Here
29
Sci2 Tool Interface Components
& practice . o .
See also bttp:/ [ sci2.wiki.cns.iu.edu/ 2.2+ User+Interface
" stool eloEs
Use | File DataPrepanation Prep ing Analysis Modeling  Visuali Help
> M dd E'lﬂonmk = O it Dsta Manager| = O
enu to rea ata) run | 'Welcome to the Science of Science Tool (Sei’). - ."?”Direcu;ry;l‘nt - Pref
. | [The pment of this tool is supparted in part by the Cyberinfrastn for |
algorlthms . | [Network Science center and the School of Library and Information Science atIndisna |E
{University, the National Science Foundation under Grant No. SBE-0738111 and
O5-0715303, and the James S McDonnell Foundation, See Science of Science
> Console to see Work log, | [Cyberinfrastructure portal (hitpeffscislisindiana.edu) for more information.
. || {Primary investigators are Katy Bomes, Indiana University and Kevin W. Bayack, SeiTech
re ferences tO S emlnal Works . | Strategies Inc. The Sci’ tool was developed by Micah W. Linnemeier, Russell J. Duhon,
L2tk A b s Chiotan Tank, ded Jestph Saption, R wbyosni inichuet B
» Data Manager to select, view, | @ s =1
save loaded, simulated, or \BamevaEropn i) B3 Remove comp b (Remove s completd]
. || m]
derived datasets. it I
! Algorithm Name Date Time % Compl
> SChedUICf to see status Of i Read Directory Hierarchy  08/15/2010  OT0217PM s
algorithm execution. | L [ ]

All workflows are recorded into a log file (see /sci2/logs/...), and soon can be re-
run for easy replication. If errors occur, they are saved in a error log to ease bug
reporting,

All algorithms are documented online; workflows are given in tutorials, see Sci2
Manual at http://sci2.wiki.cns.iu.edu

30




Tutorial Overview

8:30a Sci2 Tool Basics
>

» Load, analyze, and visualize family and business networks

>

YV VVYY
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Padgett's Florentine Families — Load, analyze, and
visualize family and business networks

Florentine families related through business ties (specifically, recorded financial ties such
as loans, credits and joint partnerships) and marriage alliances.

Node attributes
» Wealth: Each family's net wealth in 1427 (in thousands of lira).
» Priorates: The number of seats on the civic council held between 1282-1344.
» Totalities: Number of business/martiage ties in complete dataset of 116 families.
Edge attributes:
» Matriage T/F
» Business T/F

“Substantively, the data include families who were locked in a struggle for political
control of the city of Florence around 1430. Two factions were dominant in this
struggle: one revolved around the infamous Medicis, the other around the powerful
Strozzis.”

More info is at http://svitsrv25.epfl.ch/R-doc/library/ergm/html/florentine.html

32




Padgett's Florentine Families — Load, analyze, and
visualize family and business networks

*Nodes
. - id*int label*string wealth*int totalities*int
Florentine families related through E priorates*int es such

as loans, credits and joint partnershij 1 "Acciaiuoli” 10 2 53
) 2 "Albizzi" 36 3 65
Node attributes 3 "Barbadori" 55 14 0

) ! 4 "Bischeri" 44 9 12
» Wealth: Each family's net wealth 5 "Castellani” 20 18 22

» Priorates: The number of seats ¢ 6 "Ginori" 3290
7 "Guadagni" 8 14 21

» 'Totalities: Number of business/| 8 "Lamberteschi" 42 14 0 lies.
. . 9 "Medici" 103 54 53
Edge attributes: 10 "Pazzi" 48 7 0
> Marri 11 "Peruzzi" 49 32 42
arriage T/F 12 "Pucci" 310
» Business T/F 13 "Ridolfi" 27 4 38

14 "Salviati" 10 5 35

. . 15 "Strozzi" 146 29 74
“Substantively, the data include fami 1 v1ornabuoni 48 7 0 il

control of the city of Florence arour *UndirectedEdges

. | source*int target*int marriage*string business*strin
struggle: one revolved around the in &) ope 9 9 g 9 Ful

Strozzis.” 6 2 T "E"
e : 72T E

More info is at http://svitstv25.epfl] g o wpw e hl
53"T""T"

33

;,i,;.ncé | Padgett's Florentine Families — Load, compute
basic network properties & view in GUESS

h & practice

» Load *yoursci2directory*/ sampledata/ socialscience/ florentine.nwb
» Run ‘Analysis > Network Analysis Toolkit (NAT)’ to get basic propetties.

This graph claims to be undirected.

Nodes: 16

Isolated nodes: 1

Node attributes present: label, wealth, totalities, priorates
Edges: 27

No self loops were discovered.

No patallel edges were discovered.

Edge attributes:

Nonnumeric attributes:

Example value

marriag... T

busines...F

Average degree: 3.375

There are 2 weakly connected components. (1 isolates)
The largest connected component consists of 15 nodes.
Did not calculate strong connectedness because this graph was not directed.
Density (disregarding weights): 0.225

» Select network and run Visualization > GUESS’ to open GUESS with file loaded.
» Apply ‘Layout > GEM’.
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UESS was selected

puthor(s): Eytan Adar

rnplementer(s): Eytan Adar (GUESS), Russell Duhon (resizelinear, colorize fix)

ntegrator(s): Russell Dubon

Reference: Adar, Eytan, "GUESS: A Language and Interface for Graph Exploration,” CHI 2006 (http://graphesploration.cond.org/)
Document stion: https://nwb.slis.indiana.edu/community, ?n =VisualizeDat 2. GUESS

ECHO is off.

prarting GLESS...

ECHO is off.

[The irstial layout For your visuskzation is random. For a clearer visuakzation, please run & Layout from the Layout menu. (We recommend GEM, )
ECHO is off.

GUESS log file For this session can be found in

« NWE file: C:\Documents and Settings|katy\C

« List of edges of network crested through the

“ NWB file: C:\Documents and Settingsikaty\l

™' Distribution of degree for network at sty

P Dustribution of degree for network at sty
™" Distribution of degree for network. at sty

= Sequence of site betweennesses for no
" Distribution of site betweenness for nety
"' Distribution of site betweenness for ety

Graph and Network Anahysis Log

I \DOCUME ~ 1 sty \LOCALS~1 | Temp| C15hed- SEAZIStaticExeut, SSA04LALGOR] guessiog.txt ‘s + NWE File with site betweenness attribute
s 101 x
puthor(s): EvtanAdsr | Fle Edk  layot Soph View Heb
{s): Eytan Adi
Inbegraton(s): Russell Dubs k- |
B e araas A, Evtan - Medici-Acciaiuoli |
Documentation: https://1 Field Vahe |
ECHO is off. __edgesd o
Etarting GLESS. .. Business F
ECHO is off.
e il layout for your 1| 2 (€0 dandelon
ECHO is off. 5 [drected False
SUESS log File For this sess| .5 label
:\DOCLUME ~ 1 Yraty\LOCR Iabedcolor 0,0,0,255
Labedsize 12
) Scheduer :"f"*“;e“"* o
Remove From List | ™ F ﬁl "T
L 2 n
visibie true
.ﬂl wesght 1.0
1 than| " 2.0
GUESS
GLESS
|| Node Betw
| Network Az
v Load...
. GraPlot
R 2 o Object: = property: | Operator: ahua:
| Degres Dis .
J ] BarablshA Colour Show Hide Size Show Label Hide Label Change Label
| Gralot ;
b Desgres Dis Node Shape Center Change History
v GUESS
| Load...
Interpreter | Graph Modifier
| Ki} | 35
visualization - GUESS -lo|x| Pan:
Fle Edt Llayout Soript Yiew Help “grab” the background
Medici ¢ by holding left-click
Field | Value | . and moving your
g color cornfio... J g y
fixed  fakse mouse.
g height 10,0 J
& mage
E label Medici /.oom:
Iabelcolor 0,0,0,... .
labelsize 12 Using scroll wheel,
labetvi... False & 000 press the “+” and “-”
name  n9 _k] 0 g :
. SMCECEEEEN  buttons in the upper-
priorates 53 O ! Color... left hand corner, or
stroke... cadetb... . .
ave 2 X pemore right-click and move
totalities 54 Add the mouse left or right.
visible  true -@ Modify Feld. ..
.
wealth 103 lkj e e Cente; gr‘ap'h by
width 10,0 selecting “View ->
i ol - Center’.

y 44.312... :k‘j

Interpreter . Graph Modifier

aw
Object: = Property: Operator; * | Yalye:
Colour Show Hide || Size Show Label Hide Label Change Label
Format Node Labels Format Edge Labels
Node Shape Center Change History
Resize Linear Colorize
Nodes w| |labelsize = From: To: Do Resize Linear

Select Q‘ to

select/move single
nodes. Hold down
‘Shift’ to select
multiple.

Right click to modify
Color, etc.
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Graph Modifier:

visualization - GUESS =101 x| . .
Bl e Leek saetl e o | Select “all nodes” in the Object
Pucci drop-down menu and click ‘Show
i e | vae | O Label’ button.
color 255,25...
eed False g
==l e ®-... el
Em - '"Q Q dhory Select ‘Resize Linear > Nodes >
Barbadoft ; .
— labekolor 0,0,0,.. O ‘] _ _ totalities’ drop-down menu, then
5 Lamb Peruzzi) Salviati)
labebi... true ﬂ O iz type “5” and “20” into the From”
12 4
g P [Nl o ;. and To” Value box separately.
- Ridolfi:) . .
e @ O Sicia Medci) Then select ‘Do Resize Linear’.
ste 2
Qiﬁ*bi {] O Tomabuoni) O Acciaoli)
=HE m Select ‘Colorize>
pah_ 52 _ Nodes>totalities’, then select
v s f] Y O Pucciy white and enter (204,0,51) in the
_ pop-up color boxes on in the
‘ “From” and “To” buttons.
object: | [ Property: [Liuicie | opaator: [ <] vahue: | <]
Select “Format Node Labels”,
| coosr || show || mde || see || showisbel || idelsbel || changetabel | "
i ]| e replace default text {originallabel}
: = ' with your own label in the pop-up
Laemsme.d ot J| Oomuoiem 4 box ‘Enter a f tting string f
—— ox ‘Enter a formatting string for
[ Roseotnes || coboes | X & SHINg
node labels.
Interpreter | Graph Modfier |
37
Visualization - GUESS g _dm_ﬁ

He EX Loyok St Wew Hep |
Acciaiuoliz) ¢

Field | Value
e [ O
fixed  false - O
height _5.6635... O Castallani)
mage 1 o
lsbel  Accisiu... O O BarbadQ Glnort)
labelcolor 0,0,0,...
hobelsize 12 Lamb ) Peruzzi) O Salviati)
labelvi... true ﬁ Albizzic)
name nl
— R Strozzi:
: 53 O Bischeri) O Ridolfi;) O Pazzi)
Medici:
:th:e ;.adetb I Guadagnt) adick)
s 2 2 O Acciaiuoli)
fotalties o O Tornabuoni:)
weakh 10 m
width  5.6635...
x 112.01...
T m O pucet) Interpreter:
Uses Jython a combination of Java
‘ and Python.
aAw
>33 resizelinear(totalities,5,20)
>35> colorize(wealth,white,red) Try
35>

colorize(wealth, white, red)

| Interpreter | Graph Modfier |
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Workshop Overview

8:30a Sci2 Tool Basics

>

>

» Studying four major network science researchers
- Load and clean a dataset; process raw data into networks
- Find basic statistics and run various algorithms over the network
- Visualize as either a circular hierarchy or network

YV VVYY

39

Studying Four Major NetSci Researchers (ISI Data)
using Database (section 5.1.4)

Time frame: 1955-2007

Region(s): Miscellaneous
Topical Area(s): Network Science
Analysis Tvpe(s): Paper Citation Network, Co-Author Network, Bibliographic

Coupling Network, Document Co-Citation Network, Word Co-
Occurrence Network

Thomson Reuter’s Web of Knowledge (WoS) is a leading citation database. Access it
via the “Web of Science” tab at http://www.isiknowledge.com (note: access to this

database requires a paid subscription). Along with Scopus, WoS provides some of
the most comprehensive datasets for scientometric analysis.

To find all publications by an author, search for the last name and the first initial
followed by an asterisk in the author field.

bttp:/ [ sci2. wiki.cns.in.edn/ 5. 1.4+8 tudying+ Four+Major+NetS ci+Researchers+ (1514 Data)
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Data Acquisition from Web of Science

In Dec 2007, we downloaded

all papers by

» Eugene Garfield

» Stanley Wasserman

» Alessandro Vespignani

»  Albert-Laszl6 Barabasi

from

» Science Citation Index
Expanded (SCI-EXPANDED)
--1955-present

» Social Sciences Citation Index
(SSCI)--1956-present

» Arts & Humanities Citation
Index (A&HCI)--1975-present

< Be G0t Yew Go fochmals Tock Wedow Hep

Web of Science®

S )
R SR | O

i
Ganeral Search A o T |

Seloct dotabase{s) and thmespan: Lt Y
 Latest [Toem =] (updated December 0%, 2007)

vewr [3807 51
to [7507 =) (default is ol years)

& From [Teae
To remember these settings, first 3ign in or egater

Citation Databrses:
Py Science Citaton Index Expanded (9C1-EXPANDED)-1955-present
F i Secial Sciences Citation Indes (S5C1)--1056-prasent

F i Arts i Humanities Ctatscn Indes (ABHCT)--1975-present

Enter terms or phrases separated by the operatons AND, OR, NOT, or SAME, and then press SEARCH,
The search will be added 1o the search history. (22 Yiew your search history/Combane sats)

inncn]| (cinn

Wiw gur Gensral Search ttonal

TOPIC: jj Enter one or morw tarms. Seaeches within artichy tites, kayworeds, and abstracts,

& ol spll* AND *Morth Sea® (How 1o search for phrases)
I Tt anly

AUTHOR: ) Entar ons or more suthor names (see authior indes 5.
E :CVBAIAN C* DR DBRIAN C*
Author Finder: Waved help firding papers by an suthor? Use Author Findar

GROUP AUTHOR: i Entar ong or mons group names (ses grosp suthor indes 1.
Exarmple: CERN

SOURCE TITLE: {j Enter full jouma tithes (tee fis source ttles kst 50
Examgle: Carcer® OR Journal of Cancer Research and Clical Cncology

PUBLICATION YEAR: i Enter & publication year or range.
£ 2001 or 19971999

ADDRESS: ) Enter abbrevisted terms from an suthor's affitation (use sbbreviatons heip)
Example: Yale Univ SAME hosp

Resinct search by langusges and document types:

o e
(R | m——
SEAEE] T
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& practice

Comparison of Counts
No books and other non-WoS publications are covered.

Eugene Garfield 82

Stanley Wasserman

Alessandro Vespignani 42

Albert-1.4sz16 Barabasi 40
41
44

Total # Cites Total # Papers H-Index

1,525 672 31

122 35 17

451 101 33
2218
16,920

30,102

126
159
201

47
52
68

(Dec 2007)
(Dec 2008)
(April 11)
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Extract Co-Author Network

Load*yoursci2directory*/ sampledata/ scientometrics/ isi/ FourNetS ciResearchers.isi’
using 'File > Load ...*

And file with 361 records appears in the Data Manager.

Duplicates were removed, author names normalized. Log file exists.

N7 Sei2 Tool =lle k.
File Data Preparation Preprocessing  Analysis  Modeling  Visualzation Help

| B consale. = ]| i1l Data Manager =0

L osded 361 records | [ 151 Date: CUsers\User\Desktop\10-NEH-AZH-Workshop
|Removed 0 duplicate records. | [T 361 Unique IS Records

| Author names have been nomnalized.
1361 records with unique IS11Ds are available via Data Manager.
\Wrote log to

| CAUsers\User\AppDatatLocal\Templisiduplicateremoverlog2534733993422022
flet

B Scheduler =

Remove From List | || Remove completed automatically ..R:mm all complzh;
!t Algorithm Name Date Time %

* Load and Clean ISIFile 08/15/2010 07:20:43PM
~ Load and Clean IS File 08/15/2010 07:12:49 PM
« m
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Extract Co-Author Network
(see section 5.1.4.2 on correcting duplicate/ misspelled author names)

To extract the co-author network, select the 367 Unigue IST Records’ table and run
‘Data Preparation > Extract Co-Author Network’ using isi file format:

Ml Extract Co-Author Network x|

Extracts a co-authorship network From one of several supported file
types.

File Format |isi i &

(Lo ] concel|

The result is an undirected but weighted network of co-authors in the Data Manager.

Run ‘Analysis > Network > Network Analysis Toolkit (NAT)’ to calculate basic
properties: the network has 247 nodes and 891 edges.

Use ‘Analysis > Network > Unweighted and Undirected > Node Degree’ to calculate the number
of neighbors for each node independent of co-authorship weight.

To view the complete network, select the ‘Extracted Co-Authorship Network’ and run
Visualization > Networks > GUESS".

Network is loaded with random layout. In GUESS, run Tayout > GEM’ and ‘Layout
> Bin Pack’ to improve layout. Run "Seripr > Run Seript ..." and select '
yoursci2directory/ seripts| GUESS [ co-aunthor-nw.py’.
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Co-Author Network of all Four NetsSci Researchers

el \ : umber of Papers e
- \H . = Co-Authored
; — 7
Eugene Garfield iz 33

Node Size & Color Edge Size & Calor
hy Number of T
35 9
5 1
| —
1 127 1 33

45

Atool for

a.':":,',“:.f“ Co-Author Network of all Four NetsSci Researchers

Use the GUESS Graph Modifier to change
color and size coding.

Calculate node degrees in Sci2 Tool.

Stanley Wasscrman

Use a graphic program to add legend.

koo, A2 | & Node Sine & Color Edge She {kIL'nlnr
T " Co-Authored
= 127

Eugene Garficld 2

s ?

5 1

| |

1 127 1 n
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Individual Co-Author Networks
(Read/map 4 files separately)

Alessandro Vespignani Albert-Iaszl6 Barabasi
47
Network Visualization:
Node Layout
oy %o
Load and Clean ISI File was selected. % y ?...
P e el X oo
Loaded 361 records. ... e - % *
Removed 0 duplicate records. :: \\Y7 ._ =9 = o/ 2 i ..'_.!.
Author names have been normalized. © ...-' = .._':_’ SN\ . e *3 '.l:. o
361 records with unique ISI IDs are available :_. Z  —— ’ .‘. S S =®
via Data Manager. ® -_.-:‘._". . - ~ . *® e S I N
¢ o g . L oo e o o
.......... '. & i e o S o0 %0 2
Extract Co-Author Network was selected. L2 ..._ . .‘ . : .._. . . o 0_.: 4
Input Parameters: ‘s :‘. » » :': ) '-.l.
File Format: isi o e’
Network Analysis Toolkit (NAT) was selected.
Nodes: 247 .
Edges: 891 o * o, L
.......... LS LI Y o
GUESS was selected. @ » A\ L o e/ 9
o2, A\ a
L ] L 2 e Ak
o © ) | Pl SN T
v o. e ¢ -
-y e [ SN
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Network Visualization:
Color/Size Coding by Data Attribute Values

i [ ] Node Size & Color Edge Size & Color
name nlél ® Number of ..‘.li Crs Number of Times
numberofworks 101 Co-Authored
originallabel Vespignand, A e
strokecolor  black == 127 33
style 2 L 15 9
timescited 3811 g 5 1
visible true -

o — =
bt 586.75
> 107.25 1 127 1 33

Network Visualization:
Giant Component

Weak Component Clustering was selected.
Implementer(s): Russell Duhon
Integrator(s): Russell Duhon

Input Parameters:
Number of top clusters: 10
3 clusters found, generating graphs for the top 3 clusters.
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Network Visualization:
Color/Size Coding by Degree

Node Degree was selected.

Documentation:
https://nwb.slis.indiana.edu/community/?n=AnalyzeData.No
deDegree . K
- * .
.......... 1 e
3 & » A L ] .
N . / - [
. | . . .
g _.ca‘\‘ield. £® e
. 4 —y v mman, §
\
[ * ® .. ‘ \ .
2 o0 L e \o

Network Visualization:
Color/Size Coding by Betweeness Centrality

& practice

Node Betweenness Centrality was selected.

Author(s): L. C. Freeman

Implementer(s): Santo Fortunato

Integrator(s): Santo Fortunato, Weixia Huang

Reference: Freeman, L. C. (1977). A set of measuring centrality
based on betweenness. Sociometry. 40:35-41. *

. E o " .
. /!
Input Parameters: e e : .
Number of bins: 10 i—Qoanase . b it

umber of bins: 10 Ve e ) \




Atool for ']
ce ol Scicnce

arch & practice

Network Visualization:

Reduced Network After Pathfinder Network Scaling

A\ onom.H *
'""".1 s | ¥ IKI‘MO- 8
- ¥/ : . ..
-ny “‘m 'F' .f ) g
B i LA L S AN ®Fastorsatomas R’ sLorsto, V
. i Li .
®0tva, 2N :)""L‘l
LI « %A . .
g evmglez, A . "
SARe R oPones L °
. L . wBarhalemy, M
. % ®Bamat A
- -
MST-Pathfinder Network Scaling was selected. . .
e oy
Input Parameters: . By

Weight Attribute measures: SIMILARITY

Edge Weight Attribute: weight
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Atool for

ol‘xirncc
arch & practice

Network Visualization:

Circular Hierarchy Visualization

Select Co-Author Network and run Blondel Community detection:

File Data Preparation Preprocessing [Analysis| Modeling  Visualization  Help
{ -

& Console

Load and Clean ISI File was selected.
Author(s): Micah Linnemeier
Implementer(s): Micah Linnemeier

Temporal » = [j ] . r__

teq {s): Micah Li
Documentation:

Loaded:
ometrics\isi\FourNetSciResearchers.isi
Loaded 361 records.

Removed 0 duplicate records,
Author names have been normalized.

Wrote log to
Ci\Users\User\AppData\Local\Temphisidupli

https:/inwb.slis.indiana.edu/com munity/In=LoadData.ISILoadAr

CAUsers\User\Desktop\10-NEH-A&H-Workshop\DVD\sciZ\sample

361 records with unique ISTIDs are available via Data Manager.

Geospatial : - 4 D 151 Data: C:AUsers\User\Desktop\10-NEH-A&H-Workshop\DVDAsci2\sample
Topical ’ |4 7 361 Unique ISt Records
Networks » | Network Analysis Toolkit (NAT) F
| etSciResearchers.isi
Unweighted & Undirected * e meraed
Weighted & Undirected » Clustering Coefficient
Unweighted & Directed > Nearest Neighbor Degree
Weighted & Directed » Strength s Degree
4 Ef 18I Data: C:\Users\Use Degree & Strength
4 [T} 361 Unique ISI Rec Ayerage Weight vs End-point Degree
T BtactedCo-£  Strength Distribution
£3 Authorinform  yyuignt Distribution
Randomize Weights

EXER-

rlogd773522398971021

Blondel Community Detection

With parameter values

5] Blondel Community Detection

This algorithm impl ts Blondel's ¢
algorithm,

ity detection

) (@)

Weight Inurnb:rafcowﬂ'noredworks
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Network Visualization:
Circular Hierarchy Visualization

Visualize resulting file using ‘VZsualization > Networks > Circular Hierarchy’
with parameter values

‘E Circular Hierarchy @ ,

Provides Circular Hierarchy Visualization on the network.

Degree of Edge Bundiing | 0.75
Node Strength Column |timescited - [@)
Level 0 (blondel_community_level 0 ~|
Level 1 (blondel_community level 1 v)
Level 2 (blondel_community level 2 |
Level 3 (No Level -

Edge Weight Column Inumberofcoauhoredworks v]

MNode Color Column Inumhemfworks v]

Node Color Range IGn:n to red v]

55

| Network Visualization:
Circular Hierarchy Visualization

& practice

Nodes that are interlinked/clustered = S
are spatially close to minimize the i

number of edge crossings.

Node labels, e.g., .
author names.

Network structure |
using edge bundling. _“L

Color coded clustet ———»
hierarchy according to
Blondel community

Node Color

bazed oa NUMBEROFTORYS

detection algorithm.

———————

Note:

Header/footer info, legend, and more meaningful color coding are under development. y




Paper-Citation Network Layout

To extract the paper-citation network, select the 367 Unigue IS1 Records’ table and run
‘Data Preparation > Extract Paper Citation Network. *

The result is a unweighted, directed network of papers linked by citations, named
Exctracted paper-citation network in the Data Manager.

Run NAT to calculate that the network has 5,342 nodes and 9,612 edges. There are
15 weakly connected components. (0 isolates)

Run ‘Analysis > Networks > Unweighted and Directed > Weak Component Clustering’ with
parameters

F = A ¢ C
% | Weak Component Clustering . Weak Component Cluster of 5151 nodes

"y Weak Component Cluster of 38 nodes
Creates new graphs containing the top connected components.

. Weak Component Cluster of 35 nodes
. Weak Component Cluster of 27 nodes
Nurnber of top clusters 10| @ . Weak Component Cluster of 27 nodes.2

"y Weak Component Cluster of 15 nodes

elglglglgligh

[ oK |

Cancel

to identify top-10 largest components. The largest (giant) component has 5,151 nodes.

To view the complete network, select the network and run ‘VZsualization > GUESS”.




. .._m‘:s::::olgdc.m_‘_ Topic Mapping: UCSD Science Map

— e e
Science Map via Journals for FourNetSciResearchers.isi T
314 joumnal references matched out of 361 found. f :_.:...‘"1__._._
These 314 references ase associated with 13 of 13 disciplines of science and 255 of 5534 research specialties in the UCSD Map of Science. 3 ———
——
- -OM.-_-—’
Data:
WoS and Scopus for 2001-2005, 7.2 million -

papers, more than 16,000 separate journals,
proceedings, and series

Similarity Metric:
Combination of bibliographic coupling and
keyword vectors

Number of Disciplines:
554 journal clusters further aggregated into 13 main |-
1 scientific disciplines that are labeled and color

" Scencemap &= : i oo
Locate the journals from a table on the UCSD Map of Science coded ina mEtaph0r|Ca| way, €.9., Medicine is
. y blood red and Earth Sciences are brown as soil.
Journal column Joumal Name {(Abbreviated) | @ —
Dataset display name  FourMetSciResearchers.isi @
== N
How to Read the UCSD Map

—_—
Science Map vis Jourrals for NIHATTSA Publicssens om /

Circle of non-located,

UCSD Science Map P
e.g., ‘Unclassified’

with data overlay. —
records.

Header and footer with
Map legend of —— information when this

circle area size map was created, by

coding whom and using what

data set.
Listing of all data ——»
records organized into
UCSD science areas.

Listing and circle of
non-located, e.g.,
Y ‘Unclassified’ records.
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Atool for
Ascipoe Dl'xiﬂn:t:

General Network Extraction:
Weighted, Undirected Co-Occurrence Network

A B C D
1 Paper Authors References Year
2 P Al 1970
3 |P2 A2;A6 P1 1980
4 P3 ALA3 P1;P2 1990
5 P4 ALA4;AS P2 1995
6 PS5 AS;AB P1;P2;P3;P4 1995
7 P A2;AB P5 2000

Author co-occurrence network

[N Extract Network from Table

o n ekt

Column Name

Text Delimiter

Extrac

—

d table

|Authors

®x
@
_®xs
o |

@

|

|
[ Y]

*Vertices 6
1A1
2 A6
3 A2
4 A3
5A5
6 A4
*Edges 6
232
141
151
561
161
251

61

General Network Extraction:
Unweighted, Directed Bipartite Network

A B c D L J%
1 Paper Authors References Year _,’/
2 P11 A1 1970 |
3 P2 A2A6 Pl 1980 .(‘3 /
4 P3  ALA3  PLP2 1990 ./
5 P4 ALA4AS P2 1995 X ™
6 PS  AS;A6  P1;P2;P3;P4 1995 X
7.P6  A2A6  PS 2000 ® Author \
B Paper A
P [
: : @
Paper-author bipartite (2-mode) network i
Extract a bipartite netwaork from two columns in the table. If the column Mo 'O
mmmmm,muummmm
@
[authors b i
F .;3 \
I V4 |

/

[ ¥

Object: nodes based on -> | w| Property: [bipartitetype w| Operator: [== w| value: [pPaped |+

*Vertices 12

1 P1 bipartitetype "Paper"

2 A1 bipartitetype "Authors"
3 P2 bipartitetype "Paper”

4 A2 bipartitetype "Authors"
5 AG bipartitetype "Authors"
6 P3 bipartitetype "Paper”

7 A3 bipartitetype "Authors"
8 P4 bipartitetype "Paper”

9 A4 bipartitetype "Authors"
10 A5 bipartitetype "Authors"
11 P5 bipartitetype "Paper”
12 P6 bipartitetype "Paper”
*Arcs

12

34

35

62

67

82

810

89

115

1110

12 4

125
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General Network Extraction:
Unweighted, Directed Network

= 5 G 5 [ *Vertices 12
1 Paper Authors References Year 2N 1Pl %ndegree 0
2 A1 1970 M 2 Al indegree 3
3 P2 AZA6 P1 1980 ...'f'ﬁ 3 P2 indegree 0
4 P3 ALA3  PLP2 1990 Nl 4 A2 indegree 2
5 P4 ALA4AS P2 1995 Q. 5 A6 indegree 3
6 PS  ASA6  P1;P2;P3;P4 1995 \ 6 P3 indeotece 0
796  A2A6  PS 2000 ® Author 7 A3in degg e 1
B Paper = 8 P4 indegree 0
Vi 9 A4 indegree 1
\ 10 A5 indegree 2
\ 11 P5 indegree 0
Given a table, this algorithm a [ e 12 P6 indegree 0
directed edge that starts ata %
column node. \ *Arcs
Source Column [Paper 12
) 34
Target Column Authors .Pi” .M 35
Text Delmiter [ / 62
/ 67
| Analysis Modelng Visualization R Help é Q. 810
82
| IS . 89
Network Analysis Tookit (NAT) it 1110
—_— —~ - the Layout mer 4 115
i~ Unweighted & Undirected » [ 8
hel-Session-4663¢ Wﬂ""’“ » s 1; zst
Unweighted & Directed Node Indegree
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General Network Extraction:
Unweighted, Directed Paper-Citation Network

A B C D .
*
1 Paper Authors References Year Vertices 6
2 1 Al 1970 1P1
3 (P2 A2;AB P1 1980 2 PZ
4 P3  ALAI  PLP2 1990
5 P4 ALASAS P2 1995 3P3
6 P5 AS;AB P1;P2;P3;P4 1995 4 P4
7 P6  AZA6  PS 2000
- 5P5
6 P6
*Arcs
21
avena b, thsaoorit  ALCS from  papers to references 31
drected edge that starts a

achm e — _—_ 42
' ...F:'; il -.Pﬁ 54

Target Column References = g
Text Delmiter L . Pre. > g g ?
N b u. ‘s

1970 1980 1990 1995 2000
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Atool for
scipoe Dl'xiﬂn:t:

ch & practice

i

General Network Extraction:
Unweighted, Directed Bi-Partite Network

*Vertices 11

A B ¢ D
1 Paper Authors References Year 1P1 bipartitetype "Paper"
241 Al 1970 2 P2 bipartitetype "Papet”
3 P2 AZAS Pl 1980 S " "
e Tia oo o 3P1 b%part%tetype References
5 P4 AL:A4:AS P2 1995 4 P3 blpartltetype "Paper"
6 PS  AS;A6  P1;P2;P3;P4 1995 5 P2 bipartitetype "References”
PG __ATRE S 2000 6 P4 bipartitetype "Paper”
u- 7 P5 bipartitetype "Papet”
& | 8 P4 bipartitetype "References"
Ly I b 9 P3 bipartitetype "References”
e s He 10 P6 bipartitetype "Paper”
Extract a bipartite network L[S Y . Lic 11 P5 bipartitetype "References"”
wvalues may kst multiple ent .
them. - Sl *Arcs
st fricet > 23
. P4 43
Second column References 45
Text Delimiter [ [ P1 65
73
79
m,
78
XX
10 11
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ISI Paper-Citation Network Extraction

A B [ D E
1 Authors Cited References Publication Year Title Cite Me As
2 Al|A2 BENSMAN SJ, 1998, LIBR RESOUR TECH SER, V42, P147|BROI 2000 T1 A1, 2000, INT MICROBIOL, V10, P65
3 |Al BENSMAN SJ, 1999, LIBR RESOUR TECH SER, V42, P147|BROI 2000 T2 A1, 2000, P ASIST ANNU MEET, V40, P486
4 A2|A3  GARFIELD E, 1985, ESSAYS INFORMATION S, V8, P403 | GILBE 2001 T3 A2, 2001, SCIENTOMETRICS, V60, P295
5 Al ASIMOV A, 1963, GENETIC CODE | LEDERBERG J, 1972, NATUI 2001 T4 A1, 2001, J INFORM SCI, V30, P119
6 A1 |A2  AVERY OT, 1944, J EXP MED, V79, P137| SMALL H, 1985, J INF 2002 T5  Al, 2002, INFORM TECHNOL LIBR, V22, P183

Arcs from references to papers—
In the direction of information flow

| N
Ny ) “MA1, 2001, J Inform Sci, V30, P119
= IAT2000, Int Microbiol, V10, PSS g

~ M A1, 2002, Inform Technal Litr, V22, P183

¥ ” =Ml A2, 2001, Scientomelrics, V60, P295
———AT,2000, P AsistAnnu Meet, V40, P486
— 3 ;

2000 2001 2002
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. 3 Tutorial Overview
~ 4

LI g

c.‘\_r T P

VYV V VY

10:15a Sci2 Tool Novel Functionality
>

» Geospatial maps aggregated by congressional districts

>
>
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Atool for

= Horizontal line graph of NSF projects

ch & practice

Visualize as Horizontal Line Graph

ﬂ
é Takes tabular data and generates PostScript for a horizontal ine graph.

Label [Tite | _Q_J
StartDate  [StartDate =] ﬂ
EndDate  [Expraton Date -l @
] SzeBy  [Awarded Amount to Date | 2]

= - ﬂ

Page Width [8.5 2]

Page Height [ 11.0 ﬂ
¥ Scale uput? 2|

Area size equals numerical

value, e.g., award amount.

Text

Start date End date

s e - - - s = o 69
Horizontal line graph of NSF projects
NSF Awards Search via http://www.nsf.gov/awardsearch
{7 sl - Amard Search - Search All Fields - Windoms Intermet Explorer =101 x| 12 s th - Search A8 §iekds - Windaws Inbrrmet Eplorer. -1k
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2 e |
Award Search s Gt | e |
e A A e e o A ooy | Save in CSV format as *nstitution™.nsf
e | —
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= Horizontal line graph of NSF projects

ch & practice

o

Download and load a dataset of your choice or load one of the sample data files, e.g,,
Sampledata/ scientometrics | nsf] Michigan.nsf’

Run Viisualization > Temporal > Horizontal Line Graph’ using parameters:

x4
Takes tabuiar data and g tScrpt for ak dine graph.
Label |Tite :[i]
StartDate [Start Date 33’ 2
EndDate  |Expraton Date -l @ B EE NSF csv file: C:\Users\katy \Desktop\TOOLS\sci2-2011.09. 30\sar
visualized with Horizontal Line Gr

SzeBy  |Awarded Amount to Date :li] rE; it e i

e.g. 15/10/2010) |Rd ﬂ
Page Width | 8.5 2_'
Page Height [ 11.0 i]
¥ Scale Output? ﬂ

[ ]

Save visualized with Hotigontal Line Graph’ as ps or eps file. Convert into pdf and view.
Zoom to see details in visualizations of large datasets, e.g;, all NSF awards ever made.
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7= Horizontal line graph of NSF projects

ch & practice

Area size equals numerical

value, e.g., award amount.

Text, e.g,, title *

Start date End date

IMPLEMENTING T
Collaboratve Research: Tissue C r Mec!

unce and Production Dec
Payel Race, 5

I Matenals for

Prote:

Second Young Investgators Summer Research Institute of the Cons e ———
Cruantitative Social - (QSSDL _
Collaboratrve Res sembly Reseasch —

Doctoal Dissertaton Improvement Behavional Endocunolopy

Reproductve Strategres of Wild Female Geladas

Sacred Values and B

More NSF data wotkflows can be found in wiki tutorial:
5.1.3 Funding Profiles of Three Researchers at Indiana University (NSE Data)
5.2.1 Funding Profiles of Three Universities (NSF Data)

5.2.3 Biomedical Funding Profile of NSF (NSF Data)
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Geospatial maps with congressional districts

& practice

1
2
3
4
5
6
7
8
9

10
11
12

' Zip code

90095
4672
232980568
10032
10039242
46091500
191112434
27705
981959472
10065
10065

> Identify Congressional District, Latitude, Longitude

! A 1 B | c ! L2 |

1 :Zip code Congressional District Latitude Longitude
2 90095 CA-30 34.0735035 -118.6645815
3 4672 ME-02 45.818717 -69.0290345
4 232980568 VA-03 37.270472 -77.0699835

Aggregate/Count identical Congtessional Districts

l A | 8B | c [ D |
1 |Congressional District Latitude Longitude Count
2 |CA30 34.0735035 -118.6645815 4
3 |MEDQ2 45818717 690290345 2
4 |VA-03 37.270472  -77.0699835 1
5 |NY-15 408341475 -73.9342095 4
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o e orbeience Relevant Sci2 Manual entry

B i furch & practice

£iome @ £ Tools -
1 Introduction 5.3.2 Congressional District Geocoder
& 2 Gefting Started &714 Added by Scolt Weingart Ias! edited by Ted Polley on Mar 28, 2011 (view change
@ 3 Algorithms, Tools,
and Plugins 2ip code.csv
& 4 Workflow Design
¢ Region(s) United States
= 5 Sample Workflows
@ 5.1 Indvidual Lavel Analysis Type(s) Geospatial Analaysis
Studies - Micro
# 5.2 Institution Level To visualize Congressional Districts you must first extract that data from a dataset containing either ZIF codes or
Studies - Meso You can the Cong i District G plugin here. You can load any file that contains
S 53 Global Leval 9.digit U.S. ZIP codes to be geocoded. A sample file can be loaded by using ‘File > Load and following this path
Studies - Macro ‘yoursic. Y @ P csv'. Load the file in Standard csv format. Then select the file in the data
5.3.1 Geo USPTD manager and use 'Analysis > Geospatial > Congressional Distnict Geocoder with the following parameters:
(SDB Data) p -
532¢C % Congressicnal District Geocod =&
District Geocoder
& & Sample Sdence Converts US, ZIP codes to congressional districts
Studies & Online
Sendces o
& 7 Extending the Sci2 Pisce Name Column [Zin.cade. i~ |H|
Tool B |!-—‘
# 8 Relevant Datasets
and Tools —
9 Referances E Carcel
Appendix 1 Glossary
Appendix 2 CIShell 5-digits ZIP codes with multiple congressional districts, empty entries and imvalid ZIP codes that failed to be geocoded
Algorithms will list in waming messages on the console. The output table contains all columns of the input table with three
Appendix 3 Sc2 columns app Cong district, latitude, and lengitude. To view the output table save the file
Release Notes 0.5 using ‘File > Save..." and selecting the desired save location (to view the file in Excel save it as a csv file). Once the
apha file has been saved it can be viewed with your choice of program. Below the file has been opened as a csv file
__- = = = = |
1 ;le code Congressional District Latitude Longitude
2 90035 CA-30 34.0735035 -118.6645815

bhitp:/ [ sci2.wiki.cns.iu.edn/ 5.3.2+ Congressional+ District+ Geocoder
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2| Relevant CIShell plugin

Sreifarch & practice

gggc | Sh Ql | Congressional District Geocoder £ Tools ~

&1 Added by Ted Polley, last edited by Chin Hua Kong on Mar 29, 2011 (view change)

Description
This algorithm converts the given 9-digits U.S. ZIP codes (ZIP+4 codes) into its congressiga g and geographical coordinates
(latitude and longitude). The Benchmark is 50,000 ZIP codes per second. Download the pl m@

Pros & Cons

1. The algorithm is using a local database mapping with 25MB file size. It will increase the application size dramatically. So it is build
as an external plugin

2. For first execution in the same application window, the plugin required 5 seconds to load the database. The consequent execution
will not required the pre-loading phase.

3. Since some 5-digits ZIP codes contain muttiple districts, the 9-digits ZIP codes is required for the conversion. Warning message will
be printed to notice user if the given 5-digits ZIP codes contain multiple districts

4. Congressional district might be varied by each election. The database would need to be maintained and updated relatively.

Applications

This plugin only support U.S. ZIP codes. It convert 9-digits ZIP codes to their belonging congressional district. It is an external plugin since
the data size is so large. The dataset is based on the year 2008 election.

bitp:/ [ cishell.wiki.cns.in.edn/ CongressionaltDistrict+ Geocoder
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Console Messages

A

Load... was selected.

Documentation: http://wiki.cns.iu.edu/display/ CISHELL/Data+Formats

Loaded: C:\Users\katy\Desktop \NWB-SCI2\sci2-2011.04.04-v0.5a\sampledata\geo\ zip code.csv
Congressional District Geocoder was selected.

Implementer(s): Chin Hua Kong

Integrator(s): Chin Hua Kong

Documentation: https://nwb.cns.iu.edu/community/?n=SampleData.CongressionalDistrictGeocoder

Input Parameters:

Place Name Column: Zip code

District values added to Congressional District, Latitude and Longitude respectively.

There are 2 rows with "33612" ZIP code, which could not been given a congressional district.
There are 1 rows with "2472" ZIP code, which could not been given a congressional district.
There are 3 rows with "10016" ZIP code, which could not been given a congressional district.
There are 1 rows with "11203" ZIP code, which could not been given a congressional district.
There are 1 rows with "60637" ZIP code, which could not been given a congressional district.
There are 1 rows with "70118" ZIP code, which could not been given a congressional district.
There are 1 rows with "60612" ZIP code, which could not been given a congressional district.
There are 3 rows with "21205" ZIP code, which could not been given a congressional district.
There are 1 rows with "2467" ZIP code, which could not been given a congtessional district.
5-digit ZIP codes may often be insufficient, as many zip codes contain multiple congressional districts. 9-digit zip codes may be required. If a
zip code was recently created, it may also not be contained in our database.

Successfully converted 86 out of 100 ZIP codes to congressional districts.
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Geospatial maps with congressional districts

Sfarch & practice

Run Preprocessing > General > Aggregate Data’
using parameter values

 Aggegue v & |
Aggregate data in the table based on a column,
prpamcinn  (sinmea] ©)
| Zip code _NoM > L‘?J
Latitude [Average - [@]
— 1
Dielimiter for Congressional District | 'i]

(C0K ] [Coneel]

Note: Need lat/long for geomap.

Input Parameters:

Aggregate on column: Congressional District

Longitude: AVERAGE

Latitude: AVERAGE

Delimiter for Congressional District: |

Zip code: NONE

Aggregated by ": All rows of Latitude column were skipped due to no non-null, non-empty values.
Aggtegated by ": All rows of Longitude column were skipped due to no non-null, non-empty values.
Frequency of unique "Congressional District" values added to "Count" column.

"Zip code" column has been deleted from the output. Since No aggregation was mentioned for it.
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Create Geo Map (Circle Annotation)

Geo Map (Circle Annotations) was selected.

Author(s): Joseph R. Biberstine
Implementer(s): Joseph R. Biberstine
Integrator(s): Joseph R. Biberstine

Documentation: http:/ /wiki.cns.iu.edu/display/ CISHELL/Geo+Map

Input Parameters:
Longitude: Longitude
Size Circles By: CircleSize

Color Circle Exteriors By: None (no outer color)

Color Circle Interiors By: CircleSize
Exterior Color Scaling: Linear
Exterior Color Range: Yellow to Blue
Interior Color Range: Blue to Red
Size Scaling: Linear

Map: US States

Author Name:

Interior Color Scaling: Linear
Latitude: Latitude

14 rows in the table did not specify all values needed to make a circle; those rows were skipped.

Printing PostScript..
Done.

Saved: C:\Users\katy\Desktop\geoMaps2903082942930990749.ps

Save ps file, convert to pdf, view.

5| Geo Maps (circles) =
Creates a map with circle Circles are p d,
sized, and colored (inside and outside) according to columns in
the input table, Either or both kinds of coloring can also be
disabled. The table data for each dimension can be log-scaled
before processing.

Map i_ussmes > §| .
Author Name K. Borner §|
Latitude [Latitude ¢
Longtude [Longrude

Size Circles By i‘f.uunl

Size Scaling :_!-lﬂell

Color Circle Exteriors By | None (no outer colar)

Exterior Color Scaling

Esterior Color Range i_\"ell:mbo élue
Color Circle Interiors By |Count

Interior Color Scaling E\I.incll
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How to Read the Geo Map

Header and footer
with information

e < when this map

U.S. Map with

_—
data ovetlay.

Listing of map
type, author, and
parameters used.

e — G40 Map (Circle Annotation Style)
ABer: Equal-Azes Cogie Projecson
Apc 10,2011 | 09:22:16 AM

K Bormes

was created, by
whom and using
what data set.

Map legend with
color coding,

Asea (Liseas

| — a Y
- i { \a

«—
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Sci2 Demo II:
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arch & practice

Evolving collaboration networks

Tewlor sy Stonebraker Dantzich Thiel Dolal  piomh
Chen
Adkan - Larson Labow Fox
Paxson Wisnowvsky Landay obbing
Spalding Wake /avmtboch
Chu N—— Crerwinski Hie
Hellersten i Fosica
Konstan ‘Woodnff Ercagoc Guimbretiers
Bamy Baldonada b Schulman
Diston Deline
Kuchinsky Lin Brueni
Carkn Chi Gossweiler Foberson Ghayme Nowedl
Riedl - Oiahl Hearst b
L o
Mackinley ! Maisintar . Tanasse
Shoop Schank
FRatrel Hahorsen Hatzler
Pedersen Tanev Whitney
Lewis Chang Palli Hawvre
Badro sl o Pithow Fiao
Zhan e Ncens Rushall
9 Zelweger —_—
Kraemer 2 Lamping Senn
Price Stasko s IHopkins
Callahan
F Burks
vhukhenes ®
" Jones Lucas
Brown Harrold wense; 5 e Kolojechick
shnson
Card Dunmine
Eagan Botege Goldstein Gomberg
9 4 Gershon
‘Weiland
Ridin Shneiderman Mafts
Ladisch Chuah Swoffoling
° Bederson Watenberg Jain -~ Hao e
Herrmann
Furnas Flose Wiliamson ’ Karpedjiev
North o
Zhang Flaisant Widol Kaim Diwrthick
Jul Milash Seid! Schneidewind Hamison
= Ahlberg Kriegel
oan
Zacks Lainkn Noth  pange
Cam Beigel Wistrand Berchiold Moore
Ankerst
Legend Node Color Code Edge Color Code
Nodes ~ Authors gl fo-0. I— Mapping the Evolution of
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s ~ Co-aulhorship relations ¥ InfoVis Lab @ Indiana University
Edge: 4 40-40 .
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Ria e Sci2 Demo II:

)

of

Sl Evolving collaboration networks

Science

Load isi formatted file

+ sci2-vl.5-alpha » ledata » scientometrics » isi v |44

Name Date modified Type Size

[I_;"m droVespig Fre ].3_;[3 wHisld.isi
|| FourNetSciResearchers.isi 4 LaszloBarabasi.isi
] StanleyWasserman.isi 4| TestSPapers.isi

As csv, file looks like:

A | B | c | b | E | F__ |[EEEs
_1 |Abstract Authors Authors (Full Names) 'Beginning Book Seri¢ Book Serie Cited Pate (
_2 |The systematic study of Colizza, V]Barrat, AlBarthelemy, M[Vespignani, A | 2015
3 |Uncovering the hidden r¢Colizza, VIFlammini, AlSerrano, MA[Vespignani, A 110
_4 |Computer viruses can s|Vespignani, A 135
_5 |Mapping the Intemet geiDall'’Asta, L|Alvarez-Hamelin, l[Barrat, AlVazquez, AlVespignani, A | 140 LECTURE NOTES IN

Visualize each time slide separately:

[ -

M sl

19901991
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orlcience Relevant Sci2 Manual entry

= reidarch & practice

Hjoma £* Tools -
I aocichon 5.1.2 Time Slicing of Co-Authorship Networks (ISI Data)
# 2 Gefting Staried 76 Added by Ted Polley, last edited by Scolt Welngart on Mar 15, 2011 (vew change
¥ 3 Algonthms, Toals,
and Plugins AlessandroVespignan isi
& 4 Workflow Design
5 Sample Wondiows Time frame. 1990-2006
S 5.1 Indvidual Level Region(s) Indiana University, University of Rome, Yale University, Leiden Unharsity, Inemational Center for Thearstical Physics,
Studies - Micro University of Paris-Sud
2;"‘;:‘:&2!‘: Topical Areals) Informatics, Complex Network Science and System Research, Physics, Statistics, Epidemics
Putlication, and Analysis Type(s Co-Authorship Netwark
Funding Profiles hysie Typels) i
ofOne 5
Researcher The Sci* Tool supports the analysis of evohang networks. For this study. load Alessandro Vespignani's publication history from ES1. which can be
(Endiote and downloaded from Thomson's Wb of Science or loaded using ‘File > Load” and following thes path- ° i
NSF Data} AsitAlessandroVespignani isiusing ' Slice the data into five year intervals from 1390-2006 using Preprocessing > Temporal > Slice Table by Time' and the
5.1.2 Time Skcing following parameters:
ol Co
Wotworks 0151 =1 [ Sice Table by Time T o) e |
Data)
5.1.3 Funding Shce a table into groups of rows by bme.
Profiles of Three -
Researchers at = 1
Pfeipizin| Date/Time Column | Publication Year ||!
(NSF Data) —
514 Studying Cote/ilene foamt. § yryy &)
Four Major Net3d —
Researchers (151 Shice Into [veas - L-J
Data) —
 52instution Level How Many? 5 |!
Studies - Meso ==
& 5.3 Global Livel From Tine 19%0 |&)
Studies - Madie [ i
& 5 Sample Scence e 2008 |l
Studies & Onlne = el
< latrve 1
Serdces 4 Cloms S 'u
# 7 Edending the Sa2 1
7= | Align With Calendar |4
® § Relevant Datasets 1
and Toals i WeekStartsOn [Sundwy =] |!
9 References [ | |

bttp:/ [ sci2.wiki.cns.in.edu/ 5.1.2+ Time+S licing+of+ Co-Authorship+Networks+ (1S [+Data)
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Slice Table by Time

= A
W% Slice Table by Time @M
Slice a table into groups of rows by time.
Date/Time Column |Publkau'on Year > |
Date/Time Format  yyyy | ﬂ‘
Slice Into | Years el
"Slice Into” allows the user to slice the table by days, weeks, months, quarters, years, decades, and
How Many? 5 centuries. There are two additional parameters for time slicing: cumulative and align with calendar. The
former produces tables containing all data from the beginning to the end of each table's time interval, which
From Time 1290 can be seen in the Data Manager and below.
= D 101 Unique 151 Records
ToTime 2006 slice from beginning of 1990 to end of 2006 (101 records)
@] Cumulative? sbce&unbemoﬂmmendofm: (65 records)
| slice from beginning of 1990 to end of 1996 (26 records)
] Align With Calendar {71 shice from beginning of 1990 to end of 1991 (4 records)
Week Starts On Lsﬂ'i The latter option aligns the output tables according to calendar intervals
[EREH] 101 Unique ISI Records
- | slice from beginning of 2002 to end of 2006 (36 records)

™! slice from beginning of 1997 ta end of 2001 (39 records)
1 shice from beginning of 1992 to end of 1996 (22 records)
+1 slice from beginning of 1990 to end of 1991 (4 records)

Choosing "Years™ under "Slice Into” creates multiple tables beginning from January 1% of the first year. If
“Months® is chosen, it will start from the first day of the earliest month in the chosen time interval

bttp:/ [ sci2. wiki.cns.in.edu/ 5. 1.2+ Time+Shicing+of+Co-Authorship+Networks+ (1S1+Data)
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Visualize Each Network, Keep Node Positions

To see the evolution of Vespignani's co-authorship network over time, check ‘cumulative’.

Extract co-authorship networks one at a time for each sliced time table using 'Data

Preparation > Extract Co-Author Network', making sure to select "ISI" from the pop-up
window during the extraction.

To view each of the Co-Authorship Networks over time using the same graph layout,

begin by clicking on longest slice network (the 'Extracted Co-Authorship Network' under 'slice
Sfrom beginning of 1990 to end of 2006 (101 records)’) in the data manager. Visualize it in
GUESS using 'Visualization > Networks > GUESS'.

From here, run Layout > GEM' followed by "Layout > Bin Pack'. Run 'Script > Run Script

..."and select ' yoursci2directory/ scripts/ GUESS [ co-author-nw.py'.

In order to save the x, y coordinates of each node and to apply them to the other time

slices in GUESS, select 'File > Export Node Positions' and save the result as

"yoursci2directory/ NodePositions.csv'. Load the remaining three networks in GUESS using the
steps described above and for each network visualization, run 'File > Import Node Positions'
and open "yoursci2directory/ NodePositions.csv'.

To match the resulting networks stylistically with the original visualization, run 'Seripz >
Run Seript ..." and select "yoursci2directory/ seripts/ GUESS / co-author-nw.py', followed by 'Layout >
Bin Pack', for each.

bttp:/ [ sci2.wiki.cns.in.edu/ 5.1.2+ Time+S licing+of+ Co-Authorship+Networks+ (1S [+Data)
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Vespignany A
Piatioren L
® vepassa u ° '“::.:_’.-'
.I wneeren, @ Dengsin R
® waiu
1980-1991

[ ]
““::‘.r'-s._..

1580-2001 1990-2006

bttp:/ [ sci2.wiki.cns.in.edn/ 5.1.2+ Time+ Slicing+of+ Co-Authorship+Networks+(1S1+Data)
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Relevant CIShell plugin

resdarch & practice

Slice Table by Time £ Tools ~

&ClIShel
3

var L IDNE

Added by Argtha Alencar. last edited by Ted Polley on Jan 12, 2011 (yiew changa)

Description

Shice Table By Time is an algonthm to chop a table up into new tables, based on a dateftime column. |t takes the column with the date/time data, a string
describing the format of that column. the intervals that the data should be sliced into. whether or not the slices are cumalative, whether or not the slices should be
aligned with the calendar, and what day the week is considered to start on (which only matters if the slices are aligned with the calendar) as parameters

The column to use for dateftime values should have a langlc value for each row of data. It is used by the algosithm to choose which slice(s) the row should end up
in_ In order to d what d s reps d by that row, you must provide the al-gmhm with a descnptive format, in lha second pammm For instance,
a four digit year would be represented by yyyy (the default value) See hitp oda-t nel al/DateTimeFormat himl for
details of all the vanous formatting options.

The next dropdown has the available intenals to shce the table into. These include millisecends, seconds, minutes. hours, days, weeks, fortnights, manths,
quarters, years, decades, and centunes. A future version of the algorithm may include the ability to select how many of these intenals should be grouped together
at once

The checkbox that follows determines if the shces will be cumulative. I the slices are not cumulative, every row in the onginal table is in one and only one resulting
shce. However, if the shces are cumulative, evary row in the onginal table is in the slice it is for and every slice for a period after that

The checkbox that follows determines if the shces will be aligned with the calendar. For instance. if the first row is for June Tth, 2006 and yearly slices are chosen,
then the default behaior will be to have the first slice be from June Tth, 2006 to June 6th, 2007. However, if the slices are aligned with the calendar. the first slice
wall be from January 1st, 2006 to December 31st, 2006. Alignment does not affect the output for intervals of fortnights, quarters, decades, or milliseconds

I the slices are aligned with the calendar and are weekly, then the day the week stars is used to determing how they are aligned

Pros & Cons

The output of the slice algorithm is in separate tables, so a longitudinal analysis will require working with each slice separately, which can be awkward. There will
likely be future versions of the time slice algonthm that annctate the onginal table with the slice the rows belong to

Applications

When doing longitudinal analysis of data, it can be useful to consider it in chunks, such as to calculate how statistics have changed over time. Altematively. only a
particular time pericd might be of interest, and this algorithm can extract it from data for a karger time range

Implementation Details

This algonthm uses the Joda Time kbrary ively, which provides signil improved capabili P to the default Java algonthms for dates and
times

bttp:/ [ cishell.wiki.cns.iu.edn/ Slice+ Table+by+ Time
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R-Bridge

Download edu.in.cns.r_0.0.1.jar from Additional Plugins wiki page at
http://sci2.wiki.cns.iu.edu/3.2+ Additional+Plugins
Or copy them from the DVD or memory stick.

Run ‘R > Create an R Instance’ parameter should be the path to the directory on your
computer that contains Rgui.exe. Results in an ‘R Instance’ object in the Data
Manager.

To send a table from the data manager to an R Instance object, select the table and
the R Instance object together then run R > Import Table Into R’. Select ‘R > Run
Reui’ and the table is available in the R environment using the variable name you
specified as a parameter to the Import algorithm.

To pull back data from an R Instance object to the Data Manager, select the R
Instance object and run R > Export Table From R’. Choose the name of the
variable from the dropdown list.
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New Sci2 Release Preview

The next Sci2 release will become available in Dec 2011. It will add
New ISI file format reader

Publication and funding database support
Improved geographic map legend
R-bridge

Gephi.org graph layout tool

VVVVYY
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Computational Scientometrics
Cyberinfrastructures

..~ Scholarly Database: 25 million scholarly records
'*Q’* http://sdb.slis.indiana.edu

g»%,% VIVO Research Networking
& http:/ /vivoweb.org

Information Visualization Cyberinfrastructure
http://iv.cns.iu.edu

Network Workbench Tool & Community Wiki
http://nwb.cns.iu.edu

B Science of Science (Sci?) Tool
P http://sci2.cns.ju.edu

gv““b% Epidemics Tool & Marketplace
q% Forthcoming

R ClShel!

Alliance 93

SD& SCROIRIg IR Scholarly Database at Indiana University
bitp:/ [ sdb.wiki.cns.in.edn

Supports federated search of 25 million publication, patent, grant records.
Results can be downloaded as data dump and (evolving) co-author, paper-citation networks.

&3 |SCHOLARLY DATABASE @; QFHOI ARLY DATABASE

Cytrermtrastrucsass fo2 Hatwork Bence Coster, 5115 lmbians Ursrermty, Beceungiun

4 far Center, SLIS, Indiana Univernity, Bloomington

y T A AAREES

Search | Edit Profile | Admin | About | Logout

U User Non-IU User
IF rruitiple tarema are artared in & fald, they are
Bagpeye Search autematically combired using ‘OR". S0, "breast
cancer” matchas any record with ‘brasst’ or ‘cancer’ in
= N e
{ Lo ] Yo AND Batwann sormbing with
Title: ARDS. Than “brn a4t AND ¢ suld snly match

recosds that contain both
Abstract: |FNA

Double quetstion can be ured to matsh compound
Full Text: e ratravar recoads wah
First Year: | 1538 'I

Last Year: | 2008 "l Tha impartance of & partioular tarm in & quary can b
incrautad by putting & * v aitar the

cormasnd to matching the te

2y P
(] SeHooL oF LieRaRy @
- AN [HFORMATICN SCIEHCE

Register for free access at http://sdb.cns.iu.edu
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cholarly Database :: Results - Mozilla Firefox

Fle [Edt View Higtory Bookmarks Tools Help

W‘ C' 30 o) | L] | htpisssdb.sis.indiana.edufsearchiresuksrq=("artiicial inteligence”) 17 = '|marknv:kbmid1 P

2] Most Visted @ Getting Started . Latest Headines | | Hotel Kenigshof - Bod...

ﬂe'
|

R

A &

SCHOLARLY DATABASE]

Cyberinfrastructure for Network Science Center, SLIS, Indi Uni ity, Bl ington

-

Search ‘ Edit Profile ‘ Admin

Browse Results

[
About ‘ Logout |

Results 1 through 2

MNext>>

E Authors /

‘Your search returned 13,231 results in 0.295 seconds. | W/

0.

© ;

vi.- .

Total results per database: NIH: 2,103, Medline: 10,235, USPTO: 279, NSF: 614,

Year Tite

Medline LaCombe
Medline
Medline Schritt

Adlassnig

Medline Adlassnig

Medline Goldenbe

and

Medline Touretzky

g

1987 Artificial intelligence.

1989 Artificial i i @: expert sysh

1990 [Artificial intelligence in dentistry ]

2002 Artificial-i i e ted

Score (outof
5.71)

5.71
5.71
5.71

5.60

1980 Artificial intelligence.

1980 Artificial intelligence.

4.86
4.86 95

arly Database = Download - Mozilla Firefox

e Edt Wew Hatory Tock Heb

2l

artiicial AN U7 E,]-|mmm )

Q- ¢ X L [l

L) Most Visted e Getting Started . e

SCHO

Download Results

T selast all downloads,

Medline Database: =

LA

Cyberinfrastructure for Network Science Center, SLIS, Indiana University, Bloomingion

r T T
Search | EditProfie | Admin | About | Logout

Download |2Ell301] records starting st record |1 from the folloving databases:

RLY DATABASE]

Since March 2009:
Users can download networks:
Co-author

Co-investigator
Co-inventor

Patent citation

and tables for

burst analysis in NWB.

T Madiine MaSH heading table 3 Faverk
T Madline MasH qualifier table Flo 0 20w JobeHew, l & i
T Madiine author table B Back = Ll ] Search || Folders -
™ Madiine co-author table (nub format) [T e 0 J |;D hH |
T Madline master tabla Lo idiess | or\sampledatatscentometricalsch H =l
2| Hame l
DT e
T i master table [0 Medine_author tabie.csv |
o : . hor _table.csv | 960 KB
NEE Databias Ficand FoldesTesky 5.8 ) Medine_co-suther_table_(rwib_format).csv 627¢8
29 Make a new folder S Medine_master_table.csv 13,986...
T WSF cosinvestigator table(avb format) IE ) Publih this folder tothe EMedine_MesH_headng table.csv 3,453¢B
T s master table [ Web E‘mm_muﬂu:mle.m £53KB
USPTO Database: |~ SN aster_table.cov S5
Other Places i BENsF _co-nvestigator_table_(mwb_format).csv 19KB
™ usPTo Patent Cosparation Traaty table I SNsF _master_table.csv 1,303 K8
T usPTO agent table 1) scentometrics B uUsPTO_ co-inventor_table_(rmb_format).csv 18KB
™ usoTo assignes table I () My Documents Euspro_sgent _table.cov 20k8
I UsPTO citation table trub Format) 0 & My Network Places gmo'm table.csv Z3KB
™ uspTo daims table B2 @iumo-m t-aua_(mb Format).csv 7248
T USPTO corinvantor table (nwb format) [T @uwolma- rable.csy 69KB
T usPTo invantor table B2 Details 2 gmo:m_r;.ﬂm).:w 308 KB
T useTo mactar (burst format) 0 sdb E)UsPTo_master_table.csv kB
I usPTO master table (0 Fie Folder — EJuseto_patent_Cooperation_Treaty_table.csv 2KB
_Download | 0, 2008, 120mm o =la | o

| Done

A




Enabling a National
Network of Scientists

VIVO: A Semantic Approach to Creating a National Network
of Researchers (http://vivoweb.orq)

« Semantic web application and ontology
editor originally developed at Cornell U.

« Integrates research and scholarship info e =
from systems of record across
institution(s). —

« Facilitates research discovery and cross- e

disciplinary collaboration.
« Simplify reporting tasks, e.g., generate __ C et
biosketch, department report. : = e

Funded by $12 million NIH award.

Cornell University: Dean Krafft (Cornell PI), Manolo Bevia, Jim Blake, Nick Cappadona, Brian Caruso, Jon Corson-Rikert, Elly Cramer, Medha Devare,
John Fereira, Brian Lowe, Stella Mitchell, Holly Mistlebauer, Anup Sawant, Christopher Westling, Rebecca Younes. University of Florida: Mike Conlon
(VIVO and UF PI), Cecilia Botero, Kerry Britt, Erin Brooks, Amy Buhler, Ellie Bushhousen, Chris Case, Valrie Davis, Nita Ferree, Chris Haines, Rae Jesano,
Margeaux Johnson, Sara Kreinest, Yang Li, Paula Markes, Sara Russell Gonzalez, Alexander Rockwell, Nancy Schaefer, Michele R. Tennant, George Hack,
Chris Barnes, Narayan Raum, Brenda Stevens, Alicia Turner, Stephen Williams. Indiana University: Katy Borner (IU PI), William Barnett, Shanshan Chen,
Ying Ding, Russell Duhon, Jon Dunn, Micah Linnemeier, Nianli Ma, Robert McDonald, Barbara Ann O'Leary, Mark Price, Yuyin Sun, Alan Walsh, Brian
Wheeler, Angela Zoss. Ponce School of Medicine: Richard Noel (Ponce PI), Ricardo Espada, Damaris Torres. The Scripps Research Institute: Gerald
Joyce (Scripps P1), Greg Dunlap, Catherine Dunn, Brant Kelley, Paula King, Angela Murrell, Barbara Noble, Cary Thomas, Michaeleen

Trimarchi. Washington University, St. Louis: Rakesh Nagarajan (WUSTL PI), Kristi L. Holmes, Sunita B. Koul, Leslie D. McIntosh. Weill Cornell
Medical College: Curtis Cole (Weill PI), Paul Albert, Victor Brodsky, Adam Cheriff, Oscar Cruz, Dan Dickinson, Chris Huang, Itay Klaz, Peter Michelini,
Grace Migliorisi, John Ruffing, Jason Specland, Tru Tran, Jesse Turner, Vinay Varughese.

Futiications f Organsasinrs

Search results for ‘geriatrics’

UF | Clinical and Translational
Science Institute

UNIVERSITY of FLORIDA 98




University of Florida

How do you want to compare? Comparing Grants of Organizations in University of Florida s s
: s 3 Enabling a National

by Grants - 0 Network of Scientists

Who do you want to compare?

Search

Records 1-10 of 30 First « Prov Next » Last

Entity Labed Grant  Entity Type
Count
¥ Continuing 562  UF Department, Agent,
Education Hon-Acadernic Departmant,
Department
4| Forida Museum 203  Museum, Agent

of Natural History
Total Number of Grants
¥ Coege of 166  Agent, UF College, College
Agricultural and You have s
Life Sciences

7 of a maximum 10 org

Y| CoBege of 103 Agent, UF College, College .
Engineenng
L
¥ EvelynF.and 64 UF Center, Agent, Conter
Wiliam L.

McKnight Brain
Institute of the

University of Y.
Florida
4
4 international 54 UF Department, Agent,
Center Non-Academic Department, s
Department
4| Florida SeaGrant 44 UF Center, Agent, Center ¥ B

[save 2 v [ciear

Temporal Analysis (When) Temporal visualizations of the number of papers/funding

award at the institution, school, department, and people level o

Home People Organizations Research Events

versity of Florida @
487 publications activity acros
| 554 Sub-Disciplines

4 scientific sub-discipiines B

1-13 01554 First «Pre o+ Las
e Math and F
Sub-Disciplines #ol [ - ,
pubs.  activity _J f'
Pest Management Science  24.2 50 | it
J
arch 19.1 19
131 2
Clinical Cancer Research 12 2
Pain 120 25
12 23
1.1 2
0.9 2 /
— Earth Sciences ——
103 21
10.2 2
Top 280 dscipines sh
g 19

mapped 14.55% of 3,346 publications

Topical Analysis (What) Science map overlays will show where a person, department,
or university publishes most in the world of science. (in work) 100




Conlon, Mike

Associate Director and Chief Operating Officer

Co-Author Network (GraphML File

This may cnly be & smal

person's total work

Interact

Hover over a

Retresh

Sort alphabetica

Enabling a National
Network of Scientists

1Y FArT

point publication

Mike

—

Network Analysis (With Whom?) Who is co-authoring, co-investigating, co-inventing

with whom? What teams are most productive in what projects?
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National Researcher Networking
Visualization 1.0
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Québec

o
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X
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+|J
% New

I Maine

Rhode Island

Connecticut

New Jersey,
Delaware

& cyberinfrastructure for
Seey NETWORK SCIENCE CENTER
. cns.iu.edu

P Data Types
Check in the boxes next to the data
types you'd like to see displayed on the

map.

~
7>

2))

<
& ™ O People

M [ Publications
B < Patents

M /\ Funding

M O Courses

Brunsw_%
{ | Nova
| Scotia

Vermont
New Hampshird
Massachusetts

System Types
Elsevier SciVal Experts

Stanford CAP

Timeline

North
Atlantic
Ocean

Jun, 2011
Jun, 2011
>

Jun, 2011

I =
Play Pause Stop

Terms of U

Geospatial Analysis (Where) Where is what science performed by whom? Science is
global and needs to be studied globally.
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Borner, Katy
Download Data

General Statistics Enabling a National
e Network of Scientists

c«amn;nmt — | General Statistics
S * 30 publication(s) from 2001 to 2010

¢ 80 co-author(s) from 2001 to 2010

Co-Author Network

Save as Image (PNG file)

Tables
* Publications per year

=1 =1 .

Tables

Co-authors

Yom

36 publication(s) from 2001 to 2010 : 3
: Enabling a National
Network of Scientists

80 co-author(s) from 2001 to 2010

Year Count Co-Author(s)

2001 1 Chen C

2002 3 Chen C.; McMahon T., Feng Y
2003 2/Chen C.; Boyack KW

2004 17 Sengupta A ; Penumarthy S.; Thakur S.; Sooriamurthi R.; Maru J.T.; Shiffrin R.M.; Mane I; Moor KA ;

-0 WNNN N

Co-author network

<xml version="1.0" encoding="UT ">
<graphml xmlns="http://graphml.graphdrawing.org/xmlns"

xmlns:xsi="http: //vwv.v3. org/2001 /ALSchema-instance”

%xsi:achemalocation="http: //graphml, graphdraving, org/xnlns

htep: //graphml . graphdrawving. org/xmlns/l.0/graphml . x3d">
<key id="label" for="node” attr.name="label” attr.type="string” />
<key id="number of authored works" for="node" attr.name="number of_ suthored works" attr.type="int" />
<key ids"num unknowm _publication” for="node” attr.name="num unknowm _publication” attr.types="int” />
<key id="num_latest publication” for="node"” attr.name="num latest publication” attr.types="int" />
<key id="latest_publication” for="node” attr.name="latest publication” attr.type="int" />
<key id="profile url"” for="node"” attr.name="profile url"” attr.type="string” />

'
2
3
4
5
6
7
8
vl
o
15

=

Save as Image (PNG file)
Publications per year , see top file.

Co-authors Count
i 1

Ben-Miled Z
Blackwell A
Boyack K'W.
Bozicevic M
Brodbeck D.
Burkhard R.A
Chen C




Cytoscape

7 3
ggg C I 11621 CIShell - Add new Plugins, e.g., Cytoscape

Adding more alyout algorithms and network visualization interactivity

via Cytoscape http://www.cytoscape.org.

Simply add org.textrend.visnalization.cytoscape_0.0.3.jar into your /plugin directory.
Restart Sci2 Tool.

Cytoscape now shows in the Visualization Menu.

S2 Sci2 Tool

i14 Data Manager |
| ape was salacted, il = E' 151 Data: C:\Documents and Settings|borner
| Integrator(s): TexTrend Consortium (http://www.textrend = £:51 361 Unique ISI Records
Universitas Press) = %", Extracted Co-Authorship Network
Reference: Cytoscape Consortium (http://www.cytoscapeX o = =

r| Author information
C:\DOCUME~1\bornerk|L OCALS~1|Temp|CIShel-Session-6885247 765800266799 StaticExecut able
{Runner-20687 1 8271 48887037 Talgorithm >echo off

cytoscape, Cytoscapelnit[INFOJ: Cytoscapelnt static initialization

cytoscape. Cytoscapelnit[INFO]: Parent_Dir: C:\Documents and Settings\bornerk.cytoscape
(created,

Select a network in Data Manager, run Cytoscape and the tool will start with this
network loaded.
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& Cytoscape Desktop (New Session)

File

5 QaQ =

| Control Panel

! Edge-weighted Force directed (BioLayout) »

Data Panel

HOW Ee

o |

Node Attribute Browser | Edge Attribute Browser = Network Attribute Browser

Mo

Welcome to Cytoscape 2.6.2 Right-click + drag to Z00M Middle-chick + drag to PAN e
32 1Sl osGi/cishen Adoption
A4 D1 I P

USA

A number of other projects recently adopted OSGi and/or CIShell:

> Cytoscape (http:/ [ cvtoscape.ors) Led by Trey Ideker at the University of California, San Diego is
an open source bioinformatics software platform for visualizing molecular interaction
networks and integrating these interactions with gene expression profiles and other state data
(Shannon et al., 2002).

»  MAEuviz (bttps:/ [ wiki.ncsa.uinc.edu/ display/ MAE / Home) Managed by Jong Lee at NCSA is an
open-source, extensible software platform which supports seismic risk assessment based on
the Mid-America Earthquake (MAE) Center research.

Europe

Y

Taverna Workbench (bttp:/ [ taverna.org.nk) Developed by the myGrid team
(http://mygrid.org.uk) led by Carol Goble at the University of Manchester, U.K. is a free
software tool for designing and executing workflows (Hull et al., 2006). Taverna allows users
to integrate many different software tools, including over 30 000 web services.

Hungary supports natural language processing (NLP), classification/mining, and graph
algorithms for the analysis of business and governmental text corpuses with an inherently
temporal component.

»  DynaNets (hitp:/ [ www.dynanets.ors) Coordinated by Peter M.A. Sloot at the University of
Amsterdam, The Netherlands develops algorithms to study evolving networks.

> SISOB (bttp:/ [ sisob.lec.uma.es) An Obsetvatoty for Science in Society Based in Social Models.
As the functionality of OSGi-based software frameworks improves and the number and
diversity of dataset and algorithm plugins increases, the capabilities of custom tools will expand.

> TEXTrend (btip:/ / texcirend.orz) Led by George Kampis at E6tvés Lorand University, Budapest,

108




g‘é’gc |SHelll osGi/cishell-Powered Tools Support Algorithm Sharing

Common algorithm/tool pool L]
Easy way to share new algorithms
Workflow design logs
Custom tools

@ 1s
O cs
O Bio
@ SNA
Phys

Converters
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Downloads for NWB Tool Releases

DBy ok Workbeneh Tool )
http://nwb.slis.indiana.edu it
o 89,559

The Network Workbench (NWB) tool
supports tesearchers, educators, and
practitioners interested in the study of
biomedical, social and behavioral science,

!Hom People Rezearch Publications

physics, and other networks.

In February 2009, the tool provides more 169
plugins that support the preprocessing,
analysis, modeling, and visualization of
networks.

ol . _ s B 3
Dec-06 Dec-o7 Dec-of Dec-og  Augto
More than 50 of these plugins can be Hawes & Updited W03 B 0.7 + post
applied or were specifically designed for " Knouiadia Rasearch & Cresmve ACOAY: 3 v0.4 B 08+ pre
S&T Studies. (websag accessed S109) . v0.5 . 0.9 + pre
* 32309100 bela S Released W 0.6 B v1.0.0 + pre

It has been downloaded more than 65,000
times since December 2006.

Summary

Network Workbiench: A Large-Scale Networ
Toolkt for Blomedical, Social Science and A
evaluate, 3nd operate 8 unigue distributed,
stale network analysis, modeling, and visua
(NWE). The emvisioned data-code-computin)
more

ite this projec]

= 1.23.09 Ann Mecranie's ulorial abstract for 5
009

| Total # of Downloads

= 11.4.08 Two NWE Pls featured in “Connec
~ 2008, Anna Maria

il —Thip
Talas,

Director. Australian Broadcasting Corporation, Lid

[YouTube] [Full Video (00ME)]

E] Ll
See more documentation

Getinvolved

Herr 11, Bruce W., Huang, Weixia (Bonnie), Penumarthy, Shashikant & Birner, Katy. (2007). Designing Highly Flexible and Usable
Cyberinfrastructures for Convergence. In Bainbridge, William S. & Roco, Mihail C. (Eds.), Progress in Convergence - Technologies for Human

Wellbeing (Vol. 1093, pp. 161-179), Annals of the New York Academy of Sciences, Boston, MA.
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fruits

Computational Economics o '@'
e table ol
Does the type of product that a fishing A . g
country exports matter for e ol 1§ e %
subsequent economic performance? @ - yl '/ & torestand paper
. ® @ Products
vegetables ‘ ot 1 4o » m
ERENVARS NP
J cereals
: WO\ AID
- ®
coffee and cocoa F y

products

C. A. Hidalgo, B. Kiinger,

A.-1.. Barabdis:, R. Hausmann : 3 P l—a //ﬂ
: 3

vehicles

(2007) The Product Space . machinery
» L]
Conditions the Development T =
garments o
of Nations. Science 317, R -l
482 (2007). e
metallurgy $o —~_» electronics
g A -
e cobar (Learner Clasadeanon) D o J . L
Gt @ ¥ textiles ‘d/ . @l e
PRI I E § ; S
PR BN
ik coben {pecasenty) nacde wze (worid tmdo [thosands of USSH
o000 .+.000 w il s\ A
PEEE RRLER animal
agriculure chemicals
Fig. 1. The product space. (A} Hierarchically clustered proodmity (4) matrix  with their prodmity value. The sizs of the nodes are proportional to world
representing the 775 SITC-4 product classes exported in the 1998-2000  trade, and their colors are chosen fing to the classifs introduced by
period. (B) Network representation of the product space. Links are color coded  Leamer. 111
Second sight
Computational Social Science e
Studying large scale social Power struggle
networks such as Wikipedia How o You keep tackofthebubblng
marss of information that s Wikipedia?
This chaotic-looking masaic i one

attempt to show which lopics ae

Second Sight: An Emergent Mosaic of
Wikipedian Activity,
The NewScientist, May 19, 2007

network dynamics, coinciding with this
week's Inteinational Workshop and

| Conbesence on Network Science

{ In Bloomington.




Computational Epidemics
Forecasting (and preventing the effects of) the next pandemic.

Epidemic Modeling in Complex: realities, V. Colizza, A. Barrat, M. Barthelemy, A.V espignani, Conptes Rendus
Biologie, 330, 364-374 (2007).

Reaction-diffusion processes and metapopulation models in heterogeneous networks, V.Colizza, R. Pastor-Satorras,
A.Vespignani, Nature Physics 3, 276-282 (2007).

Modeling the Worldwide Spread —s|mpact or Air Travel on Globall Spread OFf Infechous Diseasess—
of Pandemic Influenza: Baseline ' ' - e

Case and Containment Interventions,

V. Colizza, A. Barrat, M. Bartheleny,
A.-J. Valleron, A.Vespignani,
PloS-Medicine 4, 13, 95-110 (2007).

duelipeust of noden
Irrigneson syin.

?’F’ “"i
*Forecasts OF THE Next Pundemic Influenza *

¥ wrigriry il iy i o
i tha 33k ) vmmmp g

Fla sl s rnges
b
et

Hogmas [Vatearm] o Pog Spwing

Computational Proteomics

What relationships exist between protein targets of all drugs and all
disease-gene products in the human protein—protein interaction network?

* =" asseag

@ © 2007 Nature Publishing Group

Yildriim, Mubammed o, 50
A., Kwan-1I Goh, ':'.u: =3 -
Michael E. Cusick, L2 N

[ =
Albert-1aszld Barabasi, o i:‘"
and Marc Vidal. (2007). L
Drug-target Network.

Nature Biotechnology
25 no. 10: 1119-1126.

oA} T .
- . rs ¥
P . =
e, .
w - (L]
P " s v
s .
o I S L X

Figure 2 Drug-target network (DT network). The DT network is generated by using the known associations between FDA-approved drugs and their target
proteins. Circles and rectangles correspond to drugs and target proteins, respectively. A link is placed between a drug node and a target node if the protein
is 2 known target of that drug. The area of the drug (protein) node is proportional to the number oﬂnmlhal lhe drug hu (the number of drugs umlﬂl
the protein). Color codes am given in the legend. Drug nodes (circles) are colored ing to their A Chemical Classifi and the
target proteins (rectangular boxes) are colored acconding to their cellular component obtained from the Gene Ontology database,
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File | C

B¢ I".

R Help
=0

Welco

il Data Manager-:

visualization of epidemic processes. -~

The Epif he NIH RM-07 d. Th
man] File (Compartmental Modeling] Networks _Simulation i o, i sh 004 award. The
Create a compartmental model
The Epi : hintan Tank, Joseph Biberstine,
Chin Hu | Wel Edit compartmental model ng, 3

| EpiC uses the Cyberinfrastructure Shell {http.ffcislwll-org] developed at the Cyberinfrastructure for

Network Science Center (httpy//ens.slis.i

I [T E— R

Please cite as follows: i
| EpiC Team. (2009). EpiC Tool. Indiana Univer§|

Exact
Network

Single-Population

‘ ! Algorithm Name

& Scheduler|
Remove From List | [/ R completed automatically |R; all cor [Vﬂuﬁuhon] Reaelp
| Line Graph
Date Time

% Complet
TPEYR] Help

@ e & cenren @Cl* e IPowered

Create an R Instance
| Run Rgui
.! Import Table Into R
| Export Table From R
—_—
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National Office for

Home Publicat

Project leader
IGeorge Kampis, PhD, DSc

an integrated TEXTrend toolkit and

University Press Ltd.

TEXTREND: Development of a business and governmental decision support
toolbox using trend- and text-analysis tools

The two interconnected objectives of the TEXTrend project are (1) the creation of

demonstrative applications in varied fields
decisions, exemplified by use cases.

TEXTREND
and Technology

s Programme

analysis

download o«

leader
service basis, and (2) the elaboration of rese
of business and governmental team

ROOLkit trend = UnIVErsity v

Team leader: Gegrae Kampis, PhD, DSc
Gydirgy Fabri, PhD, CSc
Sandor Sods, PhD

T‘n|§.an ﬁ-.-.;;'.g ﬁﬁr‘ , -

HCCI Research Institute of Economics
and Enterprises

Team leader: [stvdn Jdnos Téth, PhD
lbgnes Czibik, MSc

lagnes Makd, MSc g
Tamas Uhrin, MSc

Zoltan Varhalmi, MS¢

Glia Computer Consulting Ltd.
Team leader: Attila Bencsik, MSc
Rita Adam, MSc

Henriett Baai, BSc

[stwan Graf, MSg

Zalan Szakolezi, BSc LT,

Created at
http:fftagcrowd.com

Created by
www . wordle.net

text}end

TEXTrend adds R bridge, WEKA, Wordij, CFinder, and more.

See the latest versions of TEXTrend Toolkit modules at
bhitp:/ [ textrend.org/ index.php2option=com _contente>view=articled>id=47 & Itemid=53
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%géc IS h el l CIShell - Integrate New Algorithms

About the Cyberinfrastructure Shell Learn More...
The Cyberinfrastructure Shell (CIShell) is an open source, community-driven platform for the + CiShell Papers
integration and utilization of datasets, algorithms, tools, and computing resources. Algorithm - MMM
integration support is built in for Java and most other programming languages. Being Java based, * Algorthms
it will run on almost all platforms. The software and specification is released under an Apache 2.0 * Plugins (coming soon
License. + Misc. Tool m ion
« CIShell Web Services (coming soon)
CIShell is the basis of Network Warkbench, TexTrend, Sci® and the upcoming EpiC tool. « Screenshots

CIShell supports remote execution of algorithms. A standard web senvice definition is in

development that will allow pools of algorithms to transparently be used in a peer-to-peer, client- Getting Started

server, or web front-end fashion.
. mentation loper R 1L
* Download

CIShell Features

Getting Involved...
A framework for easy integration of new and existing algorithms written

in any programming language » Contact Us

Using CIShell, an algorithm writer can fully concentrate on creating their own algorithm in whatever
language they are comfortable with. Simple tools are provided to then take their algorithm and

CIShell Developer Guide is at http://cishell.wiki.cns.iu.edu

Additional Sci2 Plugins are athttp://sci2.wiki.cns.iuv.edu/3.2+Additional+Plugins
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=§?C IS h el l CIShell — Customize Menu

> The file Yourtooldirectory/ configuration/ defanlt_menn.xm!’ encodes the structure of
the menu system.

» In NWB Tool, the Modeling menu (left) is encoded by the following piece of

xml code:

|g =
Network Workbench Tool
File  Preprocessing Arabysis  Visualzation  Scientometnics
B Consale | Fandom Graph
e fNETwoTe workos Wiatts-Strogate Small Warld

irvestigators are Dr. b
Wasserman, and Dr. § Barabisi-Albert Scale-Free

i

The WWB toolwas g ="

Tank, Jazeph Bibersti Cherd I
Terkhorm,Heng Zhan . 1
Vespignani, and Katy Hypergrid

PRU
Network Warkbench i d
Science Certer (hitp: TARL

= | <top_menu name="mModeling">

et omno @) " nenu pid="edu. 1u. nwb. mode]ng. erdosr andongraph”/>
hitpclinwbalisindisn  Evohang Network (Weighted) <menu pid="edu.iu. nwb.modeling.smallworld"/>

<menu pid="edu.iu.nwb.modeling.barabasialbert”/>

<menu t¥pe-"break"/>

<menu pid="edu.iu.iv.modeling. p2p.can.canalgorithm"/>

<menu pid="edu.iu.iv.modeling.p2p. chord.chordalgorithm"/>

<menu pid="edu.id. iv.modeling. p2p. hypergrid. Hypergrid"/>

<menu pid="edu. iu. iv.modeling. p2p.pru.Prualgorithm”/>

<menu t¥pe-"break"/>

<menu pid="edu.iu.iv.modeling.tarl.Tar1algorithm"/>

<menu type="break"/>

<menu pid="edu. iu. nwb.modeling. discretenetworkdynamics. onDAlgorithm” />

<menu type="break"/>

<menu pid="edu. iu.nwb.modeling.weighted. evolvingnetwork" />
</top_menu>
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Ask An Expert

(if you need to report a bug for the Sci tool instead here)

Project Title | Pick any name to help us to refer to this
projectiguestion in the i

Types of Analyses T Temporal (When)
™ Geospatial (Where)
™ Topical (What) =
™ Modeling (wWhy) (Will opan in new tab.)
™ Networks (With Whom?)

Levels of | ™ Micron I (1-100 records)
™ MesoiLocal (101-10,000 records)
™ Macro/Global (> 10,000 records)

Intended Users ‘ Who is the intended audience?

Insight Needed ‘

https://sci2.cns.iu.edu/user/ask.php
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CTSI Accelerating Science Core—Services Offered

Evaluation & Monitoring: Impact and/or strength analysis for a lab,
center (e.g., NSF STCs or NIH CTSAs), institution, or region in
order to evaluate, plan, or implement research efforts. Relevant data
must be provided.

$2000-56000*

Data Compilation: The construction of a custom data set (e.g,, all

papers, patents, grants for a certain institution or area of research)

using the Scholarly Database ( ).
$3000*

Visual Interface to Community Data: Setting up an online interactive
interface similar to (relevant data must

be provided to the Core).
$6000*




Accelerating Science Core—Services Offered

VIVO Researcher Networking: Design and implementation of
interactive custom VIVO visualizations (see for
more info on VIVO and

for a map of science visualization).

$5000*

Training and Consulting in Data Mining and Visualization:
Introduction of advanced data mining and visualization tools: 2-hour
tutorials or 4-hour tutorials that also feature exemplary analyses of
client data. See for
sample slides.

$2000-$5000*

*Prices vary according to scope of work. Please contact us to request an estimate.

Q&A

Please complete the Post-Tutorial Questionnaire
so that we can further improve these tutorials.

* %k %k

Bug reports and all comments are welcome.




cyberinfrastructure for
ETWORK SCIENCE CENTER

All papers, maps, tools, talks, press are linked from http://cns.iu.edu

CNS Facebook: http://www.facebook.com/cnscenter
Mapping Science Exhibit Facebook: http://www.facebook.com/mappingscience




